SAS® Model Manager 13.1 Tutorials
Chapter 1 • SAS Model Manager Tutorials ......................................................... 1
   Overview of SAS Model Manager Tutorials ................................................. 1
   Configure Users for Tutorials ................................................................. 3
   Install and Register the Tutorial Files ...................................................... 4
   Create Tutorials Folders .............................................................................. 12

Chapter 2 • Tutorial 1: Prepare for Using SAS Workflow ................................. 15
   Overview ....................................................................................................... 15
   Make the Workflow Templates Available ................................................. 16

Chapter 3 • Tutorial 2: Performing Basic SAS Model Manager Tasks .............. 19
   Overview of SAS Model Manager Basics ...................................................... 20
   Prerequisites .................................................................................................. 20
   Organize the Model Hierarchy ..................................................................... 21
   Import Models ............................................................................................... 25
   Create Model Comparison Reports ............................................................... 29
   Scoring Models .............................................................................................. 32
   Set a Champion Model .................................................................................. 34
   View History .................................................................................................. 34
   Search for Models .......................................................................................... 35

Chapter 4 • Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports ....................................................................................................... 37
   Overview of Importing Models, Scheduling Scoring Tests, and Creating Reports ................................................................. 38
   Prerequisites .................................................................................................. 38
   Organize the Model Hierarchy ..................................................................... 39
   Import Models ............................................................................................... 45
   Create Model Comparison and Summary Reports .......................................... 50
   Scoring Models .............................................................................................. 56
   Set a Champion Model .................................................................................. 58

Chapter 5 • Tutorial 4: Publishing Models .......................................................... 61
   Overview of Publishing Models ....................................................................... 61
   Prerequisites .................................................................................................. 62
   Publish Models to the SAS Metadata Repository .......................................... 63
   Publish Models to a SAS Channel ................................................................. 66
   Publish Models to a Database ....................................................................... 67
   Update Workflow .......................................................................................... 74

Chapter 6 • Tutorial 5: Performance Monitoring and Using Dashboard Reports .... 75
   Overview of Performance Monitoring ............................................................ 75
   Prerequisites .................................................................................................. 76
   Monitor the Performance of a Classification Project Champion Model .......... 77
   Monitor the Performance of a Prediction Project Champion Model ................ 82
   Schedule Performance Monitoring ............................................................... 87
   Creating Output Formats for Performance Monitoring Reports .................... 88
   Using Dashboard Reports ............................................................................. 90
<table>
<thead>
<tr>
<th>Chapter 7 • Tutorial 6: Creating Basel II Reports</th>
<th>97</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Basel II Reports</td>
<td>97</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>97</td>
</tr>
<tr>
<td>Organize the Model Hierarchy</td>
<td>99</td>
</tr>
<tr>
<td>Import Models</td>
<td>104</td>
</tr>
<tr>
<td>Create Basel II Reports</td>
<td>107</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8 • Tutorial 7: Using Advanced Reporting</th>
<th>111</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Advanced Reporting</td>
<td>111</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>112</td>
</tr>
<tr>
<td>Create a Simple Ad Hoc Report</td>
<td>112</td>
</tr>
<tr>
<td>Create an Ad Hoc Score Range Report</td>
<td>114</td>
</tr>
<tr>
<td>Configure and Run a User-defined Score Range Report</td>
<td>115</td>
</tr>
<tr>
<td>Combining Multiple Reports</td>
<td>116</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9 • Tutorial 8: Using Advanced SAS Model Manager Features</th>
<th>119</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Using Advanced Features</td>
<td>119</td>
</tr>
<tr>
<td>Example Scope</td>
<td>120</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>120</td>
</tr>
<tr>
<td>Organize the Model Hierarchy</td>
<td>121</td>
</tr>
<tr>
<td>Create a Model Template</td>
<td>123</td>
</tr>
<tr>
<td>Import a Model</td>
<td>124</td>
</tr>
<tr>
<td>Create an Ad Hoc Variable Importance Report</td>
<td>126</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10 • Tutorial 9: Retraining Models</th>
<th>129</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Retraining Models</td>
<td>129</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>130</td>
</tr>
<tr>
<td>Define a Model Retrain Definition</td>
<td>131</td>
</tr>
<tr>
<td>Execute a Model Retrain Definition</td>
<td>133</td>
</tr>
<tr>
<td>Schedule a Retrain Definition</td>
<td>134</td>
</tr>
<tr>
<td>Viewing Retrained Models and Model Comparison Reports</td>
<td>134</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11 • Tutorial 10: Creating and Managing Portfolios</th>
<th>137</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Portfolios</td>
<td>137</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>138</td>
</tr>
<tr>
<td>Organize the Model Hierarchy</td>
<td>138</td>
</tr>
<tr>
<td>Set a Champion Model</td>
<td>142</td>
</tr>
<tr>
<td>Publish Project Champion Models from a Portfolio</td>
<td>143</td>
</tr>
<tr>
<td>Monitor Performance of Project Champion Models</td>
<td>147</td>
</tr>
<tr>
<td>Add a New Version</td>
<td>150</td>
</tr>
<tr>
<td>Add an Input Variable</td>
<td>151</td>
</tr>
<tr>
<td>Add Attachments</td>
<td>152</td>
</tr>
<tr>
<td>Add Comments</td>
<td>152</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 12 • Tutorial 11: Using My Tasks and Managing Workflows</th>
<th>153</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>153</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>154</td>
</tr>
<tr>
<td>Add a New Version</td>
<td>154</td>
</tr>
<tr>
<td>Start a Workflow</td>
<td>156</td>
</tr>
<tr>
<td>Working with Workflow Tasks</td>
<td>156</td>
</tr>
<tr>
<td>Manage Workflows</td>
<td>158</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13 • Tutorial 12: Scoring a SAS Model Manager Model Using SAS Data Integration Studio</th>
<th>163</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Using Published Models in SAS Data Integration Studio</td>
<td>163</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>164</td>
</tr>
</tbody>
</table>
Publish a Project Champion Model from SAS Model Manager 165
Score a Model Using a SAS Data Integration Studio Job 165
Declare and Publish a New Champion Model in SAS Model Manager 169
Update the Job to Use the Latest Champion Model 170
Contents
About These Tutorials

Audience

The tutorials have been designed for those who have these responsibilities:

- developing analytical models
- modeling project management
- model validation and performance testing

In addition, the tutorials cover topics of interest to these groups:

- scoring officers
- analysts
- SAS administrators
- SAS Model Manager administrators

Conventions Used in This Document

The following typographical conventions are used for all text in this document except for syntax:

**bold**
identifies an item in a window, a menu item, or a computer pathname.

**bold monospace**
identifies text that you enter in a window.

*italics*
identifies a book title or a value that is supplied by the user.

**monospace**
identifies SAS code.
About These Tutorials
Chapter 1
SAS Model Manager Tutorials

Overview of SAS Model Manager Tutorials

SAS Model Manager is a flexible model repository and model management environment for predictive and analytical models. A centralized repository and procedural templates make it easy to manage models and metadata across organizational areas and throughout the life of a model. Accountability metrics and validation of analytical steps, from creation to deployment in real time or batch scoring systems, continue until a model is retired. Storing the models in a secure, centralized repository enables you to easily organize modeling projects, develop and validate candidate models, assess candidate models for champion model selection, publish and monitor champion models in a production environment, and retrain models. The following figure illustrates the model management process that you use in SAS Model Manager:
The goal of a modeling project is to identify a champion model that a scoring application uses to predict an outcome. SAS Model Manager provides tools to evaluate candidate models, declare a project champion model, and inform your scoring officer that a predictive or analytical model is ready for validation or production. You can perform scoring tests for champion and challenger model assessment as well as publish and share the model information and performance data over established reporting channels. You can also run comparative performance benchmarks for the models in your production environment.

The tutorials for SAS Model Manager cover basic and advanced tasks that are related to model management within an enterprise computing environment. Tutorial folders are created by extracting files from the tutorial ZIP file. You use these data files to become familiar with the following basic tasks that are involved in model management:

- create a library and add data tables
- use workflows to manage modeling projects
- define and create the components of the model hierarchy
- import models
Configure Users for Tutorials

All users who perform the tutorials must be configured to use SAS Model Manager. A user must be in the Model Manager Administrator Users group to complete the setup for the tutorials. A user must also be in the Decision Manager Common Administrators group to prepare the tutorials for use with workflow.

Here are the required groups for users, listed by tutorial.

**Table 1.1  User Groups**

<table>
<thead>
<tr>
<th>Required for Tutorial</th>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutorial setup, Tutorial 1, and Tutorial 11</td>
<td>Decision Manager Common Administrators</td>
<td>This group has administrative permissions. This includes administration of the Projects, Portfolios, and Workflows categories.</td>
</tr>
<tr>
<td>All Tutorials</td>
<td>Decision Manager Users</td>
<td>This group has permission to read, add, or delete table summary information in the Data category. Users or groups must a member of this group to be able to add or delete table summary information.</td>
</tr>
<tr>
<td>Tutorial setup, Tutorial 1, and Tutorial 11</td>
<td>Model Manager Administrator Users</td>
<td>This group has administrative permissions in the Projects and Portfolio categories.</td>
</tr>
<tr>
<td>Tutorials 2 through 12</td>
<td>Model Manager Advanced Users</td>
<td>This group has permissions to read, write, and delete content in the Projects and Portfolios categories.</td>
</tr>
</tbody>
</table>

It is recommended that you add the Model Manager Administrator Users group as a member of the Decision Manager Common Administrators group and the Decision Manager Users group. The Model Manager Advanced Users group should be added as a member of the Decision Manager Users group. For more information, see Chapter 5, “Configuring Users, Groups, and Roles,” in *SAS Model Manager: Administrator's Guide*. 
Install and Register the Tutorial Files

About Installing and Registering the Tutorial Files

The tutorials are designed to use the SAS Metadata Repository. Before you use tables in the SAS Metadata Repository, the tutorial data sets and models must be placed on the SAS Application Server. An administrator who has Write access to the SAS Application Server and who has a valid SASApp user ID and password can place the tutorial files on the server.

Some tutorials require files other than data sets and models, such as score code and templates. These files do not need to be registered in the SAS Metadata Repository. The drive where you extract the tutorial ZIP file must be accessible to the SAS Metadata Repository and to tutorial users. Tutorial users can also extract tutorial ZIP files to their local computers in order to access the other files.

You can create a data library and register the tables in the SAS Metadata Repository using the Data category view in SAS Model Manager.

Note: Whether the product you have installed is SAS Model Manager or SAS Decision Manager, the application title bar contains the name of SAS Decision Manager. To see which products you have installed select Help ⇒ About

Download the Tutorial Files

The ZIP file SMM131Tutorials.zip contains the tutorials' data sets, models, workflow templates, and score code. It is available from http://support.sas.com/documentation/onlinedoc/modelmgr/. Before you begin any of the tutorials, extract the tutorial files to a computer that is accessible to the SAS Metadata Server and to the SAS Model Manager users. If your SAS Metadata Server is separate from the SAS Application Server, the files must be placed on the SAS Application Server. Follow the steps for using WinZip to extract the files. If you are using a different extraction program, follow that program's instructions for extracting the files.

1. Create a folder on your local computer to store the tutorial files. The instructions refer to this folder as <drive>.

   Note: Users must have Read and Write permission to this folder or directory.


3. Open Windows Explorer to <drive>. Right-click SMM131Tutorials.zip and select Open. Click Open.

4. Click the arrow on the Unzip button to open the Unzip from WinZip File Folder window.

   Note: If you are using a previous release of Windows, from the WinZip window, click the Extract button. The Extract dialog box appears.

5. Select <drive> from the Unzip to WinZip File Folder window.

   Note: If you are using a previous release of Windows, in the Extract to box, select <drive> and click Extract.
You can find the data and models files for each tutorial in the respective tutorial folder (for example, `<drive>\SMM131Tutorials\Data` or `<drive>\SMM131Tutorials\Models`).

**UNIX Specifics**

To complete the tutorials in a UNIX environment, first locate the CPORT files. Files that you use to import the data sets into UNIX are located in the SMM131_UNIX_cport_files.zip file that is available from http://support.sas.com/documentation/onlinedoc/modelmgr/. Instructions, as well as the sample code for performing an import, are provided in the Readme.txt file.

**Prepare Tutorial Data Sets**

**Sign In**

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter `http://hostname:port/SASDecisionManager` and press Enter. The Sign In page appears.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   *Note:* To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, `domain\myuserID`).

3. Click **Sign In**.

**Register the Tutorial Data Sets**

You can create a data library and register the tables in the SAS Metadata Repository using the Data category view in SAS Model Manager. For more information, see Chapter 3, “Managing Data Tables,” in SAS Model Manager: User's Guide.

To register new tables in the SAS Metadata Repository and add them to the list of data sources:

1. Select **Data 🔄 Tables**.

2. Click `✚` and select **Register Tables**. The Register Tables window appears.
3. Create a new Base SAS library.
   a. Select **Create a new library**.
   b. Specify **Tutorials** for the name of the new library. The name cannot exceed 60 characters.
   c. (Optional) Specify a description for the library.
   d. Specify **TutLib** for the libref.
   e. Specify the location for the new library. This location is the folder in the SAS Metadata Repository where the library is stored.
   f. Select the server and the directory where the data tables for the tutorials reside (for example, C:\SMM31Tutorials\Data\).
   g. Click **Next**.
      
      **Note:** If you click **Cancel** at this point, a folder for the library is created in the SAS Metadata Repository, but the folder does not appear in the list of data tables.

4. Click **Next** to add all of the tables to the **Selected tables** list.
   
   **Note:** If you do not want to register the tables for all of the tutorials and only want to register the tables for specific tutorials, see “Required Files for Each Tutorial” on page 7.

5. Click **Finish**. The new library is now available in the list of data tables.
Required Files for Each Tutorial

About Required Files
The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

The Required Tutorial 2 Files
The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

Tutorial 2 requires the following files and data sets in<drive>\SMM131Tutorials. The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:

• delinquency_project_input.sas7bdat
• delinquency_project_output.sas7bdat
• delinquency_scoring_input.sas7bdat
• delinquency_scoring_output.sas7bdat
• delinquency_test.sas7bdat
• delinquency_train.sas7bdat

The following model files and folders in \Models must be available on a local or network drive.

• model1 contains these files:
  • modelin1.sas7bdat
  • modelout1.sas7bdat
  • om.sas7bdat
  • result1.sas7bdat
  • score1.sas
  • target1.sas7bdat

• model2 contains these model files:
  • modelin2.sas7bdat
  • modelout2.sas7bdat
  • ot.sas7bdat
  • result2.sas7bdat
  • score2.sas
  • target2.sas7bdat

• model3 contains these model files:
• modelin3.sas7bdat
• modelout3.sas7bdat
• result3.sas7bdat
• score3.sas7bdat
• target3.sas7bdat

The Required Tutorial 3 Files
The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

Tutorial 3 requires the following files and folders in <drive>\SMM131Tutorials.

The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:
• hmeq_project_input.sas7bdat
• hmeq_project_output.sas7bdat
• hmeq_score_input.sas7bdat
• hmeq_score_output.sas7bdat
• hmeq_test.sas7bdat
• hmeq_train.sas7bdat

The following model files in \Models must be available on a local or network drive:
• \HMEQ_STAT_Item\HMEQItem.spk
• \Neural\Neural.xml
• \Reg1\miningResult.spk
• \Reg1_Interval\miningResult.spk
• \Tree1\miningResult.spk

The Required Tutorial 5 Files
The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

Tutorial 5 requires the following files and data sets in <drive>\SMM131Tutorials.

The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:
• hmeq_perf_q1.sas7bdat
• hmeq_perf_q2.sas7bdat
• hmeq_perf_q3.sas7bdat
• hmeq_perf_q4.sas7bdat
The Required Tutorial 6 Files

The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

Tutorial 6 requires the following files and folders in `<drive>`\SMM131Tutorials. This tutorial requires that the following LGD data sets in `\Data\LGD` be registered in the Tutorials library in the SAS Metadata Repository:

- lgd_proj_input.sas7bdat
- lgd_proj_output.sas7bdat
- lgd_score_input.sas7bdat
- lgd_score_output.sas7bdat

The following LGD model files in `\Models\LGD` must be available on a local or network drive:

- lgd_model_est.sas7bdat
- lgd_model_input.sas7bdat
- lgd_model_output.sas7bdat
- lgd_model_target.sas7bdat
- lgd_score.sas
- lgd_training.sas

This tutorial requires that the following PD data sets in `\Data\PD` be registered in the Tutorials library in the SAS Metadata Repository:

- hmeq_project_input.sas7bdat
- hmeq_project_output.sas7bdat
- hmeq_test.sas7bdat
- hmeq_train.sas7bdat
- pd_scoring_input.sas7bdat
- pd_scoring_output.sas7bdat

The following PD model files in `\Models\PD` must be available on a local or network drive:

- hmeq_scorecard.spk

The Required Tutorial 8 Files

The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

This tutorial requires that the following files and folders in the `<drive>`\SMM131Tutorials.
The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:
- hmeq_project_input.sas7bdat
- hmeq_project_output.sas7bdat
- hmeq_score_input.sas7bdat
- hmeq_score_output.sas7bdat
- hmeq_test.sas7bdat
- hmeq_train.sas7bdat

The following model files in \Models\Model8 must be available on a local or network drive:
- VarImportance.sas
- importance8.sas7bdat
- modelinput8.sas7bdat
- modeloutput8.sas7bdat
- nodestat8.sas7bdat
- path8.sas7bdat
- rules8.sas7bdat
- score8.sas
- target8.sas7bdat

**The Required Tutorial 10 Files**
The SAS data sets that are required for this tutorial must be on the SAS server host for
the SAS Application Server, and the models must be on your local computer or a
network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you
have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page
4.

This tutorial requires the following files and folders in the <drive>\SMM131Tutorials.

The following data sets in \Data must be registered in the Tutorials library in the SAS
Metadata Repository:
- control_table.sas7bdat
- control_table2.sas7bdat
- hmeq_seg_q1.sas7bdat
- hmeq_seg_q2.sas7bdat
- hmeq_seg_q3.sas7bdat
- hmeq_seg_q4.sas7bdat

The following model files in \Models\segmodels must be available on a local or
network drive:
- hpf_class.spk
- hpr_class.spk
- reg1.spk
The Required Tutorial 11 Files

The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

Tutorial 11 requires the following files and folders in <drive>\SMM131Tutorials. The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:

- hmeq_project_input.sas7bdat
- hmeq_project_output.sas7bdat
- hmeq_score_input.sas7bdat
- hmeq_score_output.sas7bdat
- hmeq_test.sas7bdat
- hmeq_train.sas7bdat
- hmeq_perf_q1.sas7bdat
- hmeq_perf_q2.sas7bdat
- hmeq_perf_q3.sas7bdat
- hmeq_perf_q4.sas7bdat

The following model files in \Models must be available on a local or network drive:

- \HMEQ_STAT_Item\HMEQItem.spk
- \Neural\Neural.xml
- \Reg1\miningResult.spk
- \Reg1_Interval\miningResult.spk
- \Tree1\miningResult.spk

The Required Tutorial 12 Files

The SAS data sets that are required for this tutorial must be on the SAS server host for the SAS Application Server, and the models must be on your local computer or a network drive after you extract them from the ZIP file SMM131Tutorials.zip. If you have not extracted the tutorial files, see “Install and Register the Tutorial Files” on page 4.

This tutorial requires the following files and folders in <drive>\SMM131Tutorials. The following data sets in \Data must be registered in the Tutorials library in the SAS Metadata Repository:

- score_input.sas7bdat
- score_output.sas7bdat
Create Tutorials Folders

**Sign In**

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter `http://hostname:port/SASDecisionManager` and press Enter. The Sign In page appears.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   *Note:* To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, `domain\myuserID`).

3. Click Sign In.

**Create a Top-Level Tutorials Folder**

It is recommended that you create a top-level folder for the tutorials to separate them from your test or production modeling data. This folder needs to be created only once.

1. Select **Models ➤ Projects**.

2. Click and select **New Top-Level Folder**. The New Folder window appears.

3. Enter **Tutorials** for the name for the folder.

4. Enter a description for the folder.

5. Click Save.

**Create a Folder for Your Own Tutorials**

Because multiple users might want to perform the tasks in the tutorial, it is recommended that each user create his or her own folder in the **Tutorials** folder. The administrator can also create the folders for each user.

1. Select **Tutorials**, click , and select **New Folder**. The New Folder window appears.
2. Enter a name for the folder, such as yourUserID. The examples in this tutorial use the user ID mmanalyst.

3. (Optional) Enter a description for the folder.

4. Click Save.
Chapter 2
Tutorial 1: Prepare for Using SAS Workflow

Overview

SAS Workflow provides services that work together to model, automate, integrate, and streamline business processes. It provides a platform for more efficient and productive business solutions.

SAS Workflow is used by SAS solutions that benefit from business process management. SAS Workflow Studio is a desktop client application that is used to design and deploy workflow templates.

From the SAS Model Manager, you can view a workflow, create a new workflow for a version, and view your workflow tasks, depending on the user permissions. The option that is selected and the user permissions determine the category view and content that are displayed. SAS Model Manager administrators can view the Workflows and My Tasks category views. By default, users that are not associated with the Decision Manager Common: Administration role can view only the My Tasks category view. For more information about user permissions, see Chapter 5, “Configuring Users, Groups, and Roles,” in SAS Model Manager: Administrator's Guide.

To use SAS Workflow with SAS Model Manager tutorials, you must satisfy the following prerequisites:

1. SAS Workflow Engine, SAS Workflow Services, and SAS Workflow Studio must be installed and configured. For more information, see SAS Intelligence Platform: Installation and Configuration Guide.

2. Workflow templates must be made available using SAS Workflow Studio. For more information, see “Make the Workflow Templates Available” on page 16.

3. In order to assign additional participants to tasks in SAS Model Manager, the user must have or be in a group that is assigned the workflow role of Business Administrator. Also, in order to manage workflows and assign participants, the user must be in the Decision Manager Common Administrators group, or in a group that...
is a member of the Decision Manager Common Administrators group or that is
associated with the Decision Manager Common: Administration role in SAS
Management Console. For more information, see Chapter 5, “Configuring Users,

---

Make the Workflow Templates Available

**Overview**

To use SAS Workflow with tutorials, you must make the workflow templates available
to SAS Model Manager. After the workflow templates are made available, the SAS
Model Manager administrator can use the Workflows category view to set the mappings
for the Models: Projects object. The mappings determine which workflow templates can
be selected to create workflows for modeling projects.

To save the tutorial workflow templates to the Workflow repository:

1. From SAS Workflow Studio, select **File ➪ Open** and navigate to the location where
you extracted the tutorial files (for example, C:\SMM131Tutorials\). Open the
subfolder **Workflow Templates** and select the file (for example,
MMTutorial2Workflow.xml).

2. **Log on to the server** as a SAS administrator or another authorized user.

   *Note:* By default only the SAS administrator can log on to the Workflow server.
   Before other users can log on to the server, they must be configured. For more
   information, see “Managing Workflow Template Authorization” in Chapter 5 of

3. **Add the tab attribute** of `mmapi` to the workflow template file properties.

4. **Upload a workflow template.**

5. Repeat steps 1 through 4 for each workflow definition. There are workflow templates
   for tutorial 2 and tutorial 3, and some additional examples.

6. **Verify that the workflow templates** appear in the Workflows category view of SAS
   Model Manager.

For more information, see “Deploying and Maintaining Workflows” in Chapter 5 of SAS

---

Log On to the Server

With SAS Workflow Studio, you can manage only locally stored workflow templates on
your system until you have logged on to the SAS Content Server. After you are
connected, you can access additional workflow templates that are stored in the SAS
Content Server.

To log on to the server:

1. Select **Server ➪ Log On.**

2. In the Log On window, select the host name from the **SAS environment** drop-down
   list.

3. Enter a user ID and password, and click **Log On.**
4. Click OK to close the confirmation message that might appear.

*Note:* The available host parameters are configured in the environments.xml file. Here is an example:

```xml
<environment name="localhost" default="false">
    <desc>SAS Environment: localhost</desc>
    <service-registry>
        http://localhost:8080/SASWIPClientAccess/remote/ServiceRegistry
    </service-registry>
    <service-registry interface-type="soap">
        http://localhost:8080/SASWIPSoapServices/services/ServiceRegistry
    </service-registry>
</environment>
```

For details about this configuration, see *SAS Intelligence Platform: Web Application Administration Guide*.

### Add Tag Attributes to a Workflow Template

Only those workflow templates in the Workflow repository that contain the `mmapi` tag attribute in the file properties are available to SAS Model Manager. The Workflow repository is located on the SAS Content Server.

To add a tag attribute to the file properties of a workflow template in SAS Workflow Studio:

1. Select File ➔ Properties and click Add.
2. Enter the tag value of `mmapi`.
   
   *Note:* The file properties are case sensitive. This value must be lowercase.
3. Click OK twice.

### Upload a Workflow Template

To upload a workflow:

1. From the Server menu, select the Save to Repository menu option. The Save to Workflow Repository window appears.
2. (Optional) Enter relevant comments to associate with the workflow definition.
3. Select the Activate option if you want to make the current version of the workflow template available for use in the Workflow repository by applications such as SAS Model Manager.
4. Click OK.
5. Click OK to close the confirmation message that might appear.

### Verify That the Workflow Templates Are Available and Set Mappings

To verify that the workflow templates are available in the Workflows category view of SAS Model Manager:
1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter.

2. Enter the user ID and password for a user that is in the Decision Manager Common Administrators Group or a user group that is associated with the Decision Manager Common: Administration role.

3. Verify that the uploaded workflow definition is available in the Workflows category view. From the Workflows category view, select Actions ⇒ Set Mappings. The Set Mappings window appears with a list of the available workflow templates.

There are two types of workflow templates that can be configured for use with SAS Model Manager. Workflow templates that contain tasks that are configured with an approval status are considered an approval workflow. Workflow templates that do not contain tasks with an approval status are considered a standard workflow. After you define your workflow template, save and activate it using SAS Workflow Studio. You must specify the templates to map to each type of object. This action enables you to start a new workflow using one of the templates that are associated with the specific object.

1. In the Set Mappings window, select the Models:Projects object and then select one or more templates to map to the object.

2. Select a type for each template. The types of templates that are available are Approval and Standard. For the MM Tutorial 2 Workflow and the MM Tutorial 3 Workflow templates select Standard.

3. Select the default template for the object.

4. Click OK.
Chapter 3

Tutorial 2: Performing Basic SAS Model Manager Tasks

Overview of SAS Model Manager Basics ............................................ 20

Prerequisites ................................................................. 20
  Tutorial 2 Models and Data Sets ........................................ 20
  Verify Your User ID as a Member of Model Manager User Groups .... 20
  Sign In .................................................................. 20

Organize the Model Hierarchy ...................................................... 21
  Create a Folder ......................................................... 21
  Create a New Project ............................................... 21
  Define the Variables .................................................. 22
  Define the Project Properties ....................................... 22
  Start a New Workflow (Optional) .................................... 23
  Add Attachments (Optional) ........................................ 24
  Add Comments (Optional) .......................................... 24
  Update the Workflow (Optional) .................................... 24

Import Models .................................................................. 25
  About Tutorial 2 Models ............................................ 25
  Import SAS Code Models ............................................. 25
  Set Model Properties .................................................. 27
  Map Model Variables to Project Variables ........................ 27
  Add Attachments (Optional) ........................................ 28
  Add Comments (Optional) .......................................... 28
  Update the Workflow Process (Optional) ............................ 29

Create Model Comparison Reports ............................................. 29
  Create a Model Profile Report ....................................... 29
  Create a Delta Report .................................................. 30
  Create a Dynamic Lift Report ....................................... 31
  View a Model Comparison Report ................................... 31
  Update the Workflow Process (Optional) ............................. 32

Scoring Models ................................................................ 32
  Create a Scoring Test .................................................. 32
  Execute a Scoring Test ................................................ 33
  Update the Workflow Process (Optional) ............................ 33

Set a Champion Model ....................................................... 34
  Set the Champion Model .............................................. 34
  Update the Workflow Process (Optional) ............................. 34

View History .................................................................. 34

Search for Models ............................................................. 35
Overview of SAS Model Manager Basics

After an administrator has defined your user ID in SAS Management Console, you are ready to work in SAS Model Manager. This tutorial guides you through a simple modeling project process. You can track the progress of the modeling project through an optional workflow process.

Prerequisites

Tutorial 2 Models and Data Sets

Before starting these exercises, you must extract the Tutorial 2 data sets and models from SMM131Tutorials.zip and register the data sets in the SAS Metadata Repository. For information about how to extract and register the files, see “Install and Register the Tutorial Files” on page 4. You must have access from SAS Model Manager to the tutorial files.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserId).
3. Click Sign In.
Organize the Model Hierarchy

In this exercise, you create a folder and a modeling project.

Create a Folder

To provide a folder to manage your modeling projects for this tutorial:
1. Select Models ⇒ Projects.
2. Select Tutorials ⇒ your-userID.
   
   Note: If the Tutorials folder or a folder with your user ID does not already exist, see “Create Tutorials Folders” on page 12.
3. Click and select New Folder.
4. Enter Tutorial2 for the folder name.
5. (Optional) Enter a description for the folder.
6. Click Save.

The new folder appears in the Projects category view.

Create a New Project

To create a project and define the model function:
1. Select the Tutorial2 folder.
2. Click and select New Project.
3. Enter Delinquency for the project name.
4. Select Classification as the model function.
5. Click Save. The new project opens.
Define the Variables

To define the input and output variables:

1. On the Input tab of the Variables page, click .

2. Select DELINQUENCY_PROJECT_INPUT from the Tutorials library, and click OK.

3. On the Output tab of the Variables page, click .

4. Select DELINQUENCY_PROJECT_OUTPUT and click OK.

5. Click .

6. Click Yes in the confirmation message.

Define the Project Properties

To define the properties that SAS Model Manager uses to create reports and score models:

1. On the Properties page, select Specific.

2. Specify values for these properties:

   - **Default test table**
     - Click Browse. In the Select Data Source window, select DELINQUENCY_TEST from the Tutorials library, and click OK.
Default scoring input table
Click Browse. In the Select Data Source window, select DELINQUENCY_SCORING_INPUT from the Tutorials library, and click OK.

Default scoring output table
Click Browse. In the Select Data Source window, select DELINQUENCY_SCORING_OUTPUT from the Tutorials library, and click OK.

Default train table
Click Browse. In the Select Data Source window, select DELINQUENCY_TRAIN from the Tutorials library, and click OK.

Training target variable
Enter bad.

Target event value
Enter 1.

Class target level
Click the property value field and select Binary.

Output event probability variable
Click the property value field and select POSTERIOR.

3. Click 

4. Click Yes in the confirmation message.

Start a New Workflow (Optional)
A workflow is a copy of a workflow template. A workflow can be used to track the progress of model projects at the version level. Workflow templates contain the set of tasks, participants, policies, statuses, and data objects that comprise a business task. The status that you select when completing a task determines the next task in the workflow.
The exercises in this tutorial require that you have made the workflow template available to SAS Model Manager. For more information, see “Make the Workflow Templates Available” on page 16.

To start a new workflow:
1. Click in the project toolbar.
2. Enter a name for the new workflow.
3. (Optional) Enter a description for the workflow.
4. Select the template for this tutorial from which to create the workflow.
5. Click Start.

Participants are already assigned in the workflow templates that have been provided for the tutorials. For information about how to assign additional participants to a workflow, see “Working with Workflow Participants” in Chapter 19 of SAS Model Manager: User's Guide. See also Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153 for information about how to manage workflows and work with tasks.

Add Attachments (Optional)

To add an attachment to a project:
1. On the Attachments page, click .
2. Select a file to attach and click Open.

Add Comments (Optional)

To add a comment to a project:
1. On the Comments page, enter a topic name and a comment.
2. Click to attach a file to the topic. Repeat this step to attach multiple files.
3. Click Post.

Update the Workflow (Optional)

To complete the tasks in the associated workflow:
1. Click .
2. Select Claim this task.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click Done. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

Note: For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.
Import Models

In this exercise, you import models into SAS Model Manager, set model properties, and map the model variables.

About Tutorial 2 Models

The imported models are SAS code models. SAS code models are models that were not created and exported from SAS Enterprise Miner. SAS code models consist of the SAS code and the model component files (metadata) that are used to process a model in SAS Model Manager.

The SAS code for the first model is the LOGISTICS procedure, and the SAS code for the second and third models consists of DATA step fragments. To import a SAS code file, at least three component files are required: the model score code, the model input file, and the model output file. For prediction or classification models, you also must prepare model target files.

Note: This document imports two models that use the LOGISTICS procedure. In Tutorial 2, the model is a SAS code model, which consists of individual model component files. In Tutorial 3, the model component files were created by the LOGISTICS procedure and bundled as a model package file (.spk). SAS code models and model package files use different model import methods.

Import SAS Code Models

1. Import Model 1.
   a. On the Models page, click ⬇ and select from local files.
   b. In the Choose a model template box, select Classification.
   c. Click Properties and enter Model 1 as the Name.
   d. Click Files and select the local files that match the template files. For the following files listed in the Template Files column, click in the corresponding cell in the Local Files column, and then click Browse. Navigate to <drive>:\SMM131Tutorials\Models\model1 and select the corresponding model files listed below. This action maps the tutorial model component filenames to the SAS Model Manager model component filenames.

<table>
<thead>
<tr>
<th>Template Files</th>
<th>Model Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>score.sas</td>
<td>score1.sas</td>
</tr>
<tr>
<td>modelinput.sas7bdat</td>
<td>modelin1.sas7bdat</td>
</tr>
<tr>
<td>modeloutput.sas7bdat</td>
<td>modelout1.sas7bdat</td>
</tr>
<tr>
<td>target.sas7bdat</td>
<td>target1.sas7bdat</td>
</tr>
<tr>
<td>outmodel.sas7bdat</td>
<td>om.sas7bdat</td>
</tr>
</tbody>
</table>
Note: If the same variables appear in your modelinput.sas7bdat file and your modeloutput.sas7bdat file, SAS Model Manager removes the duplicate variables from the outputvar.xml file when you import the model.

Here is the Import Model from Local Files window after the files have been mapped.

![Import Model from Local Files](image)

e. Click **OK**.

2. Import Model 2.
   a. On the **Models** page, click **Add** and select **from local files**.
   b. In the **Choose a model template** box, select **Classification**.
   c. Click **Properties** and enter **Model 2** as the **Name**.
   d. Click **Files** and select the local files from the SAS Workspace Server that match the template files. For the following files listed in the **Template Files** column, click in the corresponding cell in the **Local Files** column, and then click **Browse**. Navigate to `<drive>:\SMM131Tutorials\Models\model1` and select the corresponding model files listed below. This action maps the tutorial model component filenames to the SAS Model Manager model component filenames.

<table>
<thead>
<tr>
<th>Template Files</th>
<th>Model Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>score.sas</td>
<td>score2.sas</td>
</tr>
<tr>
<td>modelinput.sas7bdat</td>
<td>modelin2.sas7bdat</td>
</tr>
<tr>
<td>modeloutput.sas7bdat</td>
<td>modelout2.sas7bdat</td>
</tr>
<tr>
<td>target.sas7bdat</td>
<td>target2.sas7bdat</td>
</tr>
<tr>
<td>outmodel.sas7bdat</td>
<td>ot.sas7bdat</td>
</tr>
</tbody>
</table>
e. Click OK.

3. Import Model 3.
   a. On the Models page, click and select from local files.
   b. In the Choose a model template box, select Classification.
   c. Click Properties and enter Model 3 as the Name.
   d. Click Files and select the local files from the SAS Workspace Server that match the template files. For the following files listed in the Template Files column, click in the corresponding cell in the Local Files column, and then click Browse. Navigate to <drive>:\SMM131Tutorials\Models\model1 and select the corresponding model files listed below. This action maps the tutorial model component filenames to the SAS Model Manager model component filenames.

<table>
<thead>
<tr>
<th>Template Files</th>
<th>Model Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>score.sas</td>
<td>score3.sas</td>
</tr>
<tr>
<td>modelinput.sas7bdat</td>
<td>modelin3.sas7bdat</td>
</tr>
<tr>
<td>modeloutput.sas7bdat</td>
<td>modelout3.sas7bdat</td>
</tr>
<tr>
<td>target.sas7bdat</td>
<td>target3.sas7bdat</td>
</tr>
</tbody>
</table>

e. Click OK.

**Set Model Properties**

SAS Model Manager requires that the Score Code Type be set to DATA step if the score code is a DATA step fragment. If the score code is a SAS procedure, the Score Code Type must be set to SAS Program. To set the properties:

1. Open Model 1. On the Model Properties tab, select General and enter first model for tutorial 2 in the Description field. Click ...
2. Open Model 2. On the Model Properties tab, select Specific, click the Score code type box, and select DATA step. Click ...
3. Open Model 3. On the Model Properties tab, select Specific, click the Score code type box, and select DATA step. Click ...

**Map Model Variables to Project Variables**

When the names of the model output variable are not identical to the names of the project output variables, you must map the variables. To map model output variables to project output variables:

1. Map model variables for the first model. Open Model 1 from the Models page and then select Model Properties ⇒ Variables ⇒ Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a
model variable to a project variable, click in the box in the Value column, select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>POSTERIOR</td>
<td>P_1</td>
</tr>
<tr>
<td>PREDICTION</td>
<td>I_BAD</td>
</tr>
</tbody>
</table>

2. Map model variables for the second model. Open Model 2 from the Models page and then select Model Properties ⇒ Variables ⇒ Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click the box in the Value column, select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>POSTERIOR</td>
<td>PROB2</td>
</tr>
<tr>
<td>PREDICTION</td>
<td>PREDICTION</td>
</tr>
</tbody>
</table>

3. Map model variables for the third model. Open Model 3 in the Models page and then select Model Properties ⇒ Variables ⇒ Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click the box in the Value column and select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>POSTERIOR</td>
<td>P_BAD1</td>
</tr>
<tr>
<td>PREDICTION</td>
<td>PREDICTION</td>
</tr>
</tbody>
</table>

**Add Attachments (Optional)**

To add an attachment to a model:
1. Open the model and select the Attachments page.
2. Click.
3. Select a file to attach and click Open.

**Add Comments (Optional)**

To add a comment to a model:
1. Open the model and select the Comments page.
2. Enter a topic name and a comment.
3. Click ☑️ to attach a file to the topic. Repeat this step to attach multiple files.
4. Click Post.

**Update the Workflow Process (Optional)**

To complete the tasks in the associated workflow:

1. Click 📄
2. Select **Claim this task**.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

**Create Model Comparison Reports**

In this exercise, you create several model comparison reports that are used in the selection and approval of a champion model. After you create the reports, you view the reports on the **Reports** page. The reports enable you to evaluate candidate models in a version or across versions by assessing the structure, performance, and resilience of your models.

**Create a Model Profile Report**

The Model Profile report creates three tables to display the profile data that is associated with the model input variables, output variables, and target variables. To create this report:

1. Open the **Delinquency** project and select the **Reports** page.
2. Click ☑️ and select **Model Profile**.
3. Enter **profile_model1** for the name of the report.
4. Select **PDF** for the output type.
5. Select **Seaside** for the style of the report. When the SAS default option is selected, the default style and themes are used in generating the report. For example, the SAS default style for the HTML output type is HTMLBLUE.
6. Select **Model 1** from the list.
7. Click Run. The report is generated and appears in the default viewer based on the selected output type.

**Create a Delta Report**

The Delta report compares the profile data for two models and notes the differences. To create this report:

1. Open the Delinquency project and select the Reports page.
2. Click and select Delta.
3. Enter delta_mod1mod2 for the name of the report.
4. Select HTML for the output type.
5. Select SAS default for the style of the report. When the SAS default option is selected, the default style and themes are used in generating the report. For example, the SAS default style for the HTML output type is HTMLBLUE.
6. Select models Model 1 and Model 2 from the list.

7. Click Run. The report is generated and appears in the default viewer based on the selected output type.
Create a Dynamic Lift Report

The Dynamic Lift report provides visual summaries of the performance of one or more models for predicting a binary outcome variable performance. To create this report:

1. Open the Delinquency project and select the Reports page.
2. Click ☿ and select Dynamic Lift.
3. Enter lift_mod1mod3 for the name of the report.
4. Select PDF for the output type.
5. Select Seaside for the style of the report.
6. Select models Model 1 and Model 3 from the list.
7. (Optional) Enter 3 for the control group response rate.
8. (Optional) Enter 1 for the prior probability.

![New Report dialog box](image)

9. Click Run. The report is generated and appears in the default viewer based on the selected output type.

View a Model Comparison Report

To view a model comparison report:

1. Open the Delinquency project and select the Reports page.
2. Double-click the report name to open the report.

   Note: If user credentials are required, then specify a user ID and password that have permission to access the SAS Content Server.

3. Use the PDF or HTML viewer to distribute or print a copy of the report.
4. Close the PDF or HTML viewer.

For a detailed description of the model comparison reports, see SAS Model Manager: User's Guide.
**Update the Workflow Process (Optional)**

To complete the tasks in the associated workflow:

1. Click 📋.
2. Select **Claim this task**.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

**Scoring Models**

In this exercise, you create a scoring test that is used to run the score code of a model and produce scoring results. You use the results to determine the scoring accuracy and to analyze the model performance. The scoring test uses data from a scoring test input table, and then generates the results in a scoring test output table.

**Create a Scoring Test**

1. Open the **Delinquency** project and select the **Scoring** page.
2. Click +.
3. Enter **M1** for the name.
4. (Optional) Enter **test1** for the description.
5. Select the **Model 1** model from the list.
6. Select **Test** for the type of scoring test. Accept the default number of observations (1000 rows) to be read from the scoring input table.
   
   *Note:* A best practice is to select **Test** before beginning all scoring tests. Later, when you are satisfied with the results of running the scoring test and you are ready to put the test into production, you can change the type to **Production**.
7. Verify that the value you previously specified for the **Default score input table** project property appears in the **Input table** box. To select a table, click **Browse** and select the table **Tutorials.DELINQUENCY_SCORE_INPUT**. Click **OK**.
8. Verify that the value you previously specified for the **Default score output table** project property appears in the **Output table** box. To select a table, click **Browse** and select the table **Tutorials.DELINQUENCY_SCORE_OUTPUT**. Click **OK**.
9. Click **Next**.
10. Verify that the scoring output table variables are mapped to the available variables. The variable mapping is as follows:
Output Variables | Available Model and Scoring Variables
--- | ---
AGE | AGE
CUSTKEY | CUSTKEY
EVERDEFAULT | EVERDEFAULT
GENDER | GENDER
NUMCARDS | NUMCARDS
POSTERIOR | P_1
PREDICTION | I_BAD

11. Click Next.
12. Select the configured SAS Application Server (for example, SASApp).
13. Click Save.

**Execute a Scoring Test**

1. Select the M1 scoring test and click 🏅
2. To view the results, click the Results tab.

**Update the Workflow Process (Optional)**

To complete the tasks in the associated workflow:

1. Click 🏅
2. Select **Claim this task**.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

### Set a Champion Model

In this exercise, you set a champion model.

**Set the Champion Model**

To set a champion model:

1. On the **Models** page, select **Model 1**.
2. Click to set the model as the project champion model. The value in the **Role** column changes to **Champion**.

---

### Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:

1. Click 📊.
2. Select **Claim this task**.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

### View History

In this example, you view the history of a project. Select the **History** page to view the history log for changes to the project, the history of models that were published at the project and model level, and the history of scoring, performance, and retrain jobs that were executed.
Search for Models

In this example, you search for a model in the Projects category view.

To search for a model:

1. Click.
2. Select Current as the location.
3. Enter Model 2 for the model.
4. Click Search.
5. Select Model 2 from the Search Results and click to view or edit the model. Click OK.
6. Click Close.
Chapter 4
Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports

Overview of Importing Models, Scheduling Scoring Tests, and Creating Reports .......................................................... 38

Prerequisites ................................................................................................................................................................. 38
Tutorial 3 Models and Data Sets .................................................................................................................................. 38
Verify Your User ID as a Member of Model Manager User Groups ............................................................................. 38
Sign In ........................................................................................................................................................................... 39

Organize the Model Hierarchy ....................................................................................................................................... 39
Create a Folder .............................................................................................................................................................. 39
Create a New Project .................................................................................................................................................... 39
Define the Variables ...................................................................................................................................................... 40
Define the Project Properties .................................................................................................................................... 43
Start a New Workflow (Optional) .................................................................................................................................. 44
Add Attachments (Optional) .......................................................................................................................................... 44
Add Comments (Optional) ............................................................................................................................................ 45
Update the Workflow Process (Optional) .......................................................................................................................... 45

Import Models ................................................................................................................................................................. 45
Register SAS Enterprise Miner Models in the SAS Metadata Repository (Optional) ......................................................... 45
Import Models from a SAS Metadata Repository ............................................................................................................. 46
Import PMML Models ...................................................................................................................................................... 46
Import Model Package Files ........................................................................................................................................... 47
Map Model Variables to Project Variables ..................................................................................................................... 48
Add Attachments (Optional) .......................................................................................................................................... 49
Add Comments (Optional) ............................................................................................................................................ 50
Update the Workflow Process (Optional) ........................................................................................................................ 50

Create Model Comparison and Summary Reports ......................................................................................................... 50
Create a Model Profile Report .......................................................................................................................................... 50
Create a Delta Report ...................................................................................................................................................... 51
Create a Dynamic Lift Report ....................................................................................................................................... 52
Training Summary Data Set Report (Optional) ................................................................................................................ 53
Create an Interval Target Variable Report .................................................................................................................... 54
View a Model Comparison and Summary Reports ....................................................................................................... 55
Update the Workflow Process (Optional) ........................................................................................................................ 55

Scoring Models ................................................................................................................................................................. 56
Create a Scoring Test ...................................................................................................................................................... 56
Schedule a Scoring Test .................................................................................................................................................. 57
Update the Workflow Process (Optional) ........................................................................................................................ 58

Set a Champion Model ...................................................................................................................................................... 58
Overview of Importing Models, Scheduling Scoring Tests, and Creating Reports

SAS Model Manager provides several methods to import SAS models into a project version. You can import your models into a project version from the SAS Metadata Repository, SAS Enterprise Miner or SAS/STAT model package files, SAS code, R models, and PMML models. SAS macros are also available so that you can use SAS code to import or register SAS models into your project version.

SAS Model Manager provides several model comparison reports that are used in the selection and approval of a champion model. After you create the reports, you view the reports on the Reports page of a project. The reports enable you to evaluate candidate models in a version or across versions by assessing the structure, performance, and resilience of your models.

Instead of executing a scoring test, you can schedule a scoring test to run on a particular date and time. You can also schedule how often you want the scoring test to run. Advanced settings enable you to set the scheduling server, the batch server to run the scoring test, and the location of the scoring job definition in the SAS Metadata Repository.

The tutorial provides examples and step-by-step directions for performing these tasks.

Prerequisites

Tutorial 3 Models and Data Sets

Before starting these exercises, you must extract the Tutorial 3 data sets and models from SMM131Tutorials.zip, and register the data sets in the SAS Metadata Repository. For information about how to extract and register the files, see “Install and Register the Tutorial Files” on page 4. You must have access from SAS Model Manager to the tutorial files.

Importing models requires that you know where the SAS Model Manager administrator installed the Tutorial 3 models.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the **Groups and Roles** tab. Review the **Member of** pane and locate the group **Model Manager Advanced Users**. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.


---

**Sign In**

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter `http://hostname:port/
SASDecisionManager` and press Enter. The **Sign In** page appears.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on
the operating system that is used to host the application server. Your password is case
sensitive.

   *Note:* To schedule jobs in a Windows environment, you must include the domain
   name when entering your user ID (for example, `domain\myuserID`).

3. Click **Sign In**.

---

**Organize the Model Hierarchy**

In this exercise, you create a folder and a modeling project.

**Create a Folder**

To provide a folder to manage your modeling projects for this tutorial:

1. Select **Models ⇒ Projects**.

2. Select **Tutorials ⇒ yourUserID**.

   *Note:* If the **Tutorials** folder or a folder with your user ID does not already exist, see
   “Create Tutorials Folders” on page 12.

3. Click **New Folder**.

4. Enter **Tutorial3** for the folder name.

5. (Optional) Enter a description for the folder.

6. Click **Save**.

The new folder appears in the **Projects** category view.

**Create a New Project**

To create a project that is associated with the classification model function:

1. Select the **Tutorial3** folder.

2. Click **New Project**.

3. Enter **HMEQ** for the project name.

4. Select **Classification** as the model function.
5. Click **Save**. The new project opens.

To create a project that is associated with the prediction model function:

1. Select the **Tutorial3** folder.
2. Click ![Folder](image) and select **New Project**.
3. Enter **HMEQ-Interval** for the project name.
4. Select **Prediction** as the model function.

5. Click **Save**. The new project opens.

**Define the Variables**

To define the input and output variables for the **HMEQ** project:

1. Select the **Variables** page, and on the **Input** tab, click ![Variables](image).
2. Select **HMEQ_PROJECT_INPUT** from the **Tutorials** library, and click **OK**.
3. Click the **Output** tab and click ![Variables](image).
4. Select HMEQ_PROJECT_OUTPUT from the Tutorials library, and click OK.

5. Click 📋.

6. Click Yes in the confirmation message.

To define the input and output variables for the HMEQ-Interval project:

1. Select the Variables page, and on the Input tab click 📋.

2. Select HMEQ_PROJECT_INPUT from the Tutorials library, and click OK.

3. Click the Output tab and then click 📋.
4. Enter the following project variable properties and click **OK**.

**Name**
Enter **P_DEBTINC**

**Description**
Enter an optional description.

**Type**
Select **Numeric**.

**Measurement**
Enter **INTERVAL**.

**Length**
Enter **8**.

5. Click **Yes**.

6. Click **Yes** in the confirmation message.
**Define the Project Properties**

To define the properties that SAS Model Manager uses to create reports and score models:

1. Select **Properties ⇒ Specific**.

2. Specify values for these properties:

   **Default test table**
   
   Click **Browse**. In the Select Data Source window, select `HMEQ_TEST` from the `Tutorials` library, and click **OK**.

   **Default scoring input table**
   
   Click **Browse**. In the Select Data Source window, select `HMEQ_SCORING_INPUT` from the `Tutorials` library, and click **OK**.

   **Default scoring output table**
   
   Click **Browse**. In the Select Data Source window, select `HMEQ_SCORING_OUTPUT` from the `Tutorials` library, and click **OK**.

   **Default train table**
   
   Click **Browse**. In the Select Data Source window, select `HMEQ_TRAIN` from the `Tutorials` library, and click **OK**.

   **Training target variable**
   
   Enter **BAD** for the `HMEQ` project that has a model function type of classification.

   Enter **DEBTINC** for the `HMEQ-Interval` project that has a model function type of prediction.

   **Target event value**
   
   Enter **1** for the `HMEQ` project that has a model function type of classification.

   **Class target level**
   
   Select **Binary** for the `HMEQ` project that has a model function type of classification.

   Select **Interval** for the `HMEQ-Interval` project that has a model function type of prediction.

   **Output event probability variable**
   
   Select **score** for the `HMEQ` project that has a model function type of classification.

   **Output prediction variable**
   
   Select **P_DEBTINC** for the `HMEQ-Interval` project that has a model function type of prediction.

3. Click **OK**.

4. Click **Yes** in the confirmation message.

Here is an example of the `HMEQ` project properties:
**Start a New Workflow (Optional)**

A workflow is a copy of a workflow template. A workflow can be used to track the progress of model projects at the version level. Workflow templates contain the set of tasks, participants, policies, statuses, and data objects that comprise a business task. The status that you select when completing a task determines the next task in the workflow.

The exercises in this tutorial require that you have made the workflow template available to SAS Model Manager. For more information, see “Make the Workflow Templates Available” on page 16.

To start a new workflow:

1. Click 📊 in the project toolbar.
2. Enter a name for the new workflow.
3. (Optional) Enter a description for the workflow.
4. Select the template for this tutorial from which to create the workflow.
5. Click Start.

Participants are already assigned in the workflow templates that have been provided for the tutorials. For information about how to assign additional participants to a workflow, see “Working with Workflow Participants” in Chapter 19 of *SAS Model Manager: User's Guide*. See also Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153 for information about how to manage workflows and work with tasks.

**Add Attachments (Optional)**

To add an attachment to a project:

1. On the Attachments page, click ➕.
2. Select a file to attach and click Open.
Add Comments (Optional)

To add a comment to a project:

1. On the Comments page, enter a topic name and a comment.
2. Click to attach a file to the topic. Repeat this step to attach multiple files.
3. Click Post.

Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:

1. Click .
2. Select Claim this task.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click Done. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

Note: For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

Import Models

In this exercise, you import models into SAS Model Manager from the SAS Metadata Repository, a PMML model file, and a SAS model package file. Then you map the model variables. Before you import the model, verify that the model type is identical to the value of the project Model function property, classification, or prediction. For more information, see “Create a New Project” on page 39.

Register SAS Enterprise Miner Models in the SAS Metadata Repository (Optional)

If you do not already have models registered in the SAS Metadata Repository, you can use the models in the SMM131Tutorials\Models directory to complete the next exercise.

To register a model from SAS Enterprise Miner to the SAS Metadata Repository:

1. From SAS Enterprise Miner, select File ⇒ Open Model Package.
2. Navigate to the location of the folder that contains the files. For this example, use <drive>:\SMM131Tutorials\Models\Reg1, the folder that was installed by the SAS Model Manager administrator. For more information, see “Install and Register the Tutorial Files” on page 4. Click OK.
3. Run the model.
4. After the model run is complete, right-click the node in the SAS Enterprise Miner Diagram Workspace, and select Create Model Package. The new SPK filename
appears under the Model Packages folder in your SAS Enterprise Miner Project Navigator.

5. Right-click the filename and select **Register** to copy the SPK file from the SAS Enterprise Miner server to your computer.

**Import Models from a SAS Metadata Repository**

If your SAS Enterprise Miner 5.3 (or later) model files are registered in the SAS Metadata Repository, then you can use SAS Model Manager to import the files.

To import a model from the SAS Metadata Repository:

1. Select the **Models** page.
2. Click ![folder icon] and select from the SAS Metadata Repository.
3. Navigate to the location of the file and select the model file to import.
4. Enter a name for the model and click **OK**.

**Import PMML Models**

You can use SAS Model Manager to import PMML 4.0 (or later) models that are produced by another software application, such as SAS Enterprise Miner. PMML 4.0 (or later) is supported by SAS Model Manager for creating DATA step score code when importing models. This capability enables you to include a PMML model in scoring tasks, reporting, and performance monitoring.

To import a PMML model:

1. Click ![folder icon] and select from a PMML file.
2. On the **Browse** tab, click **Select a Model** and navigate to the location of the file. For this tutorial, use `<drive:\SMM131Tutorials\Models\Neural\`, the folder that was installed by the SAS Model Manager administrator. For more information, see “Install and Register the Tutorial Files” on page 4.

3. Select the **Neural.xml** file and click **Open**.

4. Enter **Neural** for the name for the model.

5. (Optional) On the **Record Location** tab, enter the location of the PMML file.

6. Click **OK**.

**Import Model Package Files**

SAS Enterprise Miner and SAS/STAT linear model package files contain complete model information. You can import SAS Enterprise Miner and SAS/STAT models even if they are not registered in the SAS Metadata Repository. For information about how to create a package file, see *SAS Model Manager: User's Guide*.

To import a model from a SAS Package File:

1. Select the **Models** page.

2. Click ![folder](/folder_icon.png) and select **from a SAS package file**.

3. On the **Browse** tab, click **Select a Model** and navigate to the location of the file. For this example, use `<drive:\SMM131Tutorials\Models\Reg1\`, the folder that was installed by the SAS Model Manager administrator. For more information, see “Install and Register the Tutorial Files” on page 4.

4. Select the **miningResult.spk** file and click **Open**.
5. Enter \textit{Reg 1} for the name for the model.
6. (Optional) On the \textbf{Record Location} tab, enter the location of the SAS package file.
7. Click \textbf{OK}.
8. Repeat steps 2 through 7 to import a second package file that is located in `<drive:\SMM131Tutorials\Models\Tree1`. Name the model \textit{Tree 1}.
9. Repeat steps 2 through 7 to import a third package file that is located in `<drive:\SMM131Tutorials\Models\HMEQ_STAT_Item`. Name the model \textit{HMEQ_STAT_Item}.
10. Repeat steps 2 through 7 to import a fourth package file that is located in `<drive:\SMM131Tutorials\Models\HPForest`. Name the model \textit{HPForest}.
11. Repeat steps 2 through 7 in the \textit{HMEQ-Interval} project to import a prediction model with an interval target. The package file is located in `<drive:\SMM131Tutorials\Models\Reg1_Interval`. Name the model \textit{Reg1_Interval}.

\textbf{Map Model Variables to Project Variables}

When the names for the model output variable are not identical to the names for the project output variables, you must map the variables.

To map model output variables to project output variables:

1. Map model variables for the first model. Open \textit{Neural} from the \textbf{Models} page and then select \textbf{Model Properties} $\Rightarrow$ \textbf{Variables} $\Rightarrow$ \textbf{Output Mapping}. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the \textbf{Value} column, select a variable, and click $\checkmark$.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>P_BAD1</td>
</tr>
</tbody>
</table>

2. Map model variables for the second model. Open \textit{Reg 1} from the \textbf{Models} page and then select \textbf{Model Properties} $\Rightarrow$ \textbf{Variables} $\Rightarrow$ \textbf{Output Mapping}. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the \textbf{Value} column, select a variable, and click $\checkmark$.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>EM_EVENTPROBABILITY</td>
</tr>
</tbody>
</table>

3. Map model variables for the third model. Open \textit{Tree 1} from the \textbf{Models} page and then select \textbf{Model Properties} $\Rightarrow$ \textbf{Variables} $\Rightarrow$ \textbf{Output Mapping}. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the \textbf{Value} column, select a variable, and click $\checkmark$.
4. Map model variables for the fourth model. Open `HMEQ_STAT_Item` from the Models page and then select Model Properties → Variables → Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the Value column, select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>EM_EVENTPROBABILITY</td>
</tr>
</tbody>
</table>

5. Map model variables for the fourth model. Open `HPForest` from the Models page and then select Model Properties → Variables → Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the Value column, select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>P_BAD1</td>
</tr>
</tbody>
</table>

6. Map model variables for the fifth model. Open `Reg1_Interval` from the Models page and then select Model Properties → Variables → Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the Value column, select a variable, and click.

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>P_BAD1</td>
</tr>
<tr>
<td>P_DEBTINC</td>
<td>P_DEBTINC</td>
</tr>
</tbody>
</table>

Add Attachments (Optional)

To add an attachment to a model:
1. Open the model and select the Attachments page.
2. Click +.
3. Select a file to attach and click Open.
Add Comments (Optional)

To add a comment to a model:
1. Open the model and select the Comments page.
2. Enter a topic name and a comment.
3. Click to attach a file to the topic. Repeat this step to attach multiple files.
4. Click Post.

Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:
1. Click .
2. Select Claim this task.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click Done. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

Note: For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

Create Model Comparison and Summary Reports

In this exercise, you create several model comparison reports that are used in the selection and approval of a champion model. Of the reports, the Model Profile report can be created for any type of model. The Interval Target Variable report can be created only for a prediction model. After you create the reports, you view them on the Reports page. The reports enable you to evaluate candidate models in a version or across versions by assessing the structure, performance, and resilience of your models.

Create a Model Profile Report

The Model Profile report creates three tables to display the profile data that is associated with the model input variables, output variables, and target variables. To create this report:
1. Open the HMEQ project and select the Reports page.
2. Click and select Model Profile.
3. Enter profile_tree1 for the report name.
4. (Optional) Enter a description for the report.
5. Select PDF for the output type.
6. Select Seaside for the style of the report.
7. Select the model **Tree 1** from the list.

8. Click **Run**. The report is generated and appears in the default viewer based on the selected output type.

**Create a Delta Report**

The Delta report compares the profile data for two models and notes the differences. To create this report:

1. Open the **HMEQ** project and select the **Reports** page.
2. Click **Δ** and select **Delta**.
3. Enter **delta_reg1tree1** for the report name.
4. (Optional) Enter a description for the report.
5. Select **HTML** for the output type.
6. Select **SAS default** for the style of the report.
7. Select the models **Reg 1** and **Tree 1** from the list.
8. Click Run. The report is generated and appears in the default viewer based on the selected output type.

Create a Dynamic Lift Report

The Dynamic Lift report provides visual summaries of the performance of one or more models for predicting a binary outcome variable performance. To create this report:

1. Open the HMEQ project and select the Reports page.
3. Enter lift_reg1tree1 for the report name.
4. (Optional) Enter a description for the report.
5. Select HTML for the output type.
6. Select Seaside for the style of the report.
7. Select the models Reg 1 and Tree 1 from the list.
8. (Optional) Enter 3 for the control group response rate.
9. (Optional) Enter 1 for the prior probability.
10. Accept the default input table of Tutorials.HMEQ_TEST.
11. Click Run. The report is generated and appears in the default viewer based on the selected output type.

**Training Summary Data Set Report (Optional)**

**About the Report**
A Training Summary Data Set report creates frequency and distribution charts that summarize the train table variables. Using the default train table, SAS Model Manager generates data sets that contain numeric and character variable summaries, and variable distributions. These data sets are used to create the summary report.

In this exercise, you create a Training Summary Data Set report.

**Create a Training Summary Data Set Report**
To generate a Training Summary Data Set report for a version:

1. Open the HMEQ project and select the Reports page.
2. Click and select Training Summary Data Set.
3. Enter TrainingSummaryDataSet_HMEQ for the report name.
4. (Optional) Enter a description for the report.
5. Select HTML for the output type.
6. Select Seaside for the style of the report.
7. Accept the default input table of Tutorials.HMEQ_TRAIN.
8. Select the variables to include in the summary data set.
Create an Interval Target Variable Report

The Interval Target Variable report creates two plots so that you can view the actual versus predicted values for a model and the actual versus residual values for a model. This report can be created only for prediction models.

Note: This report is created based on the sample data of the default test table. By default, the sample size is 1000 and the sample seed is 12345. When the sample size is less than or equal to 5000, the chart that is created in the report is a scatter plot. When the sample size is greater than 5000, the chart that is created in the report is a heat map. If you are using your own data sets and want to create an Interval Target Variable Report that contains a heat map, contact your SAS Administrator. Request that the Sample size for models with an interval target configuration setting be changed to greater than 5000.

To create this report:
1. Open the HMEQ-Interval project and select the Reports page.
2. Click Run and select Interval Target Variable.
3. Enter reg1_interval for the report name.
4. (Optional) Enter a description for the report.
5. Select PDF for the output type.
6. Select Seaside for the style of the report.
7. Select the model Reg1_Interval from the list.
8. Accept the default input table of Tutorials.HMEQ_TEST.

9. Click Run. The report is generated and appears in the default viewer based on the selected output type.
9. Click **Run**. The report is generated and appears in the default viewer based on the selected output type.

### View a Model Comparison and Summary Reports

To view a model comparison report:

1. Open the **HMEQ** or **HMEQ-Interval** project and select the **Reports** page.

2. Double-click the report name to open the report.

   **Note**: If user credentials are required, then specify a user ID and password that have permission to access the SAS Content Server.

3. Use the PDF or HTML viewer to distribute or print a copy of the report.

4. Close the PDF or HTML viewer.

For a detailed description of the model comparison reports, see *SAS Model Manager: User's Guide*.

### Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:

1. Click **Claim this task**.

2. Select **Claim this task**.

3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.

4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

**Scoring Models**

In this exercise, you create a scoring test that is used to run the score code of a model and produce scoring results. Then you schedule the scoring test to run on a particular date and time. You can also schedule how often you want the scoring test to run. You use the results to determine the scoring accuracy and to analyze the model performance. The scoring test uses data from a scoring input table, and then generates the results in a scoring output table.

**Create a Scoring Test**

1. Open the HMEQ project and select the **Scoring** page.
2. Click +. The Add a New Scoring Test wizard appears.

![Add a New Scoring Test](image)

3. Enter **Tree1** for the name.
4. (Optional) Enter **test1** for the description.
5. Select the **Tree 1** model from the list.
6. Select **Test** for the type of scoring test. Accept the default number of observations (1000 rows) to be read from the scoring input table.

   *Note:* A best practice is to select **Test** before beginning all scoring tests. Later, when you are satisfied with the results of running the scoring test and you are ready to put the test into production, you can change the type to **Production**.
7. Click Next.
8. Verify that the value you previously specified for the **Default score input table** project property appears in the **Input table** box. To select a table, click **Browse** and select the table **Tutorials.HMEQ_SCORE_INPUT**. Click **OK**.

9. Verify that the value you previously specified for the **Default score output table** project property appears in the **Output table** box. To select a table, click **Browse** and select the table **Tutorials.HMEQ_SCORE_OUTPUT**. Click **OK**.

10. Click **Next**. Verify that the output variables are mapped to the available variables.

11. Click **Next**.

12. Select the configured SAS Application Server (for example, **SASApp**).

13. Click **Save**.

**Schedule a Scoring Test**

1. Select the **Tree1** scoring test from the list and click **Go**.

   ![New Schedule Window](image)

2. On the **Recurrence** tab, select the recurrence pattern.

3. Specify the criteria for when and how often the job should be run.

   To set the start date, click the calendar and select a start date and time. The default is today’s date. It is recommended to schedule it at least 5 minutes out, so that you can complete the next steps.

4. (Optional) Click **Advanced**. Select the server that schedules the job from the **Scheduling server** list box. Select the batch server that runs the job from the **Batch server** list box. Click **Browse** to select a location for the scoring job definition in the SAS Metadata Repository. Click **OK**.

5. Click **OK**.

6. After the job has been scheduled, a confirmation message appears. Click **Close**.

7. Click the **Results** tab to view the scoring test results, after the scheduled scoring test job has been completed.

   *Note*: Scoring test job schedules cannot be edited. To change the schedule, delete the schedule and create a new schedule.

   To delete a schedule, select the schedule and then click **Delete**.
**Update the Workflow Process (Optional)**

To complete the tasks in the associated workflow:

1. Click ![image].
2. Select **Claim this task**.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click **Done**. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.

---

**Set a Champion Model**

In this exercise, you set a champion model for each project.

**Set the Champion Model for the HMEQ Project**

To set a champion model:

1. On the **Models** page, select **Tree 1**.
2. Click ![image] to set the model as the project champion model. The value in the **Role** column changes to **Champion**.

**Flag the Challenger Model for the HMEQ Project**

You can flag a challenger model after the champion model has been set. To flag a challenger model:

1. On the **Models** page, select **Reg 1**.
2. Click ![image] to flag the model as a challenger. The value in the **Role** column changes to **Challenger**.

**Set the Champion Model for the HMEQ-Interval Project**

To set a champion model:

1. On the **Models** page, select **Reg1_Interval**.
2. Click ![image] to set the model as the project champion model. The value in the **Role** column changes to **Champion**.
Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:

1. Click 📊.
2. Select Claim this task.
3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
4. Click Done. The workflow process continues to the next task.
5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

Note: For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.
Overview of Publishing Models

SAS Model Manager provides a comprehensive publishing environment for model delivery that supports sharing model and performance data. SAS Model Manager publishes models to different channels, and to the SAS Metadata Repository. SAS Model Manager can also publish classification, prediction, and segmentation (cluster) models to a database, if the model has a score code type of SAS DATA step. SAS Model Manager cannot publish PMML models to a database. Application software, such as SAS Data Integration Studio or SAS Enterprise Guide, enables you to access models through the SAS Metadata Server and to submit on-demand and batch scoring jobs.

SAS Model Manager publishes models to defined publication channels. Authorized users who subscribe to a channel can choose to receive e-mail notifications when updated models are ready to deploy to testing or production scoring servers, and are published to a publication channel. From a publication channel, you can extract and validate the scoring logic, deploy models to a production environment, and monitor the performance of your models.
The tutorial provides examples and step-by-step directions for performing these tasks.

---

**Prerequisites**

**Tutorial 4 Models**

The exercises in this tutorial depend on some of the properties of the specific models that were added in Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 38. Use the projects, versions, or models that are specified here. This tutorial is designed to follow Tutorial 3.

**Prepare a Database for Use with SAS Model Manager**

To publish a model to a database from SAS Model Manager, the Database Administrator (DBA) needs to prepare the database. For more information, see “Preparing a Database for Use with SAS Model Manager” in Chapter 11 of SAS In-Database Products: Administrator's Guide.

*Note:* Contact your system administrator if you do not have the appropriate permissions to the installation and configuration directories on the SAS Model Manager server.

**Verify Your User ID as a Member of Model Manager User Groups**

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

**Sign In**

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter `http://hostname:port/SASDecisionManager` and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   *Note:* To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, `domain\myuserID`).
3. Click Sign In.
Publish Models to the SAS Metadata Repository

In this exercise, you use the comprehensive publishing environment for model delivery to share models. Model delivery most often includes model score code and its associated input and output metadata. You publish a model and the champion model for a project to the SAS Metadata Repository. In the next exercise, you publish a champion or challenger model to a database. Application software, such as SAS Data Integration Studio or SAS Enterprise Guide, can access the MiningResults object through the SAS Metadata Server and submit on-demand or batch scoring jobs.

Publish a Model from the Models Page

SAS Model Manager uses the SAS Folder view to publish the model to any folder that is accessible to the user. You can publish a model to folders in the SAS Foundation repository or to folders in custom repositories that are created in SAS Management Console to reflect the structure of your business organization.

Note: SAS Model Manager cannot publish R models.

To publish a model to the SAS Metadata Repository:

1. In the Tutorial3 folder, open the HMEQ project and select the Models page.
2. Select Tree 1 and click .
3. Enter Tree 1 as the publish name for the model. It might already be populated.
4. Click Browse to select the location to publish the model to.
5. Click Publish.

CAUTION:

When a MiningResults object exists in the same folder and has the same name or model UUID, decide whether to overwrite the metadata for this
stored object. Do not overwrite an existing MiningResults object unless you are certain that the model is from the same project in SAS Model Manager.

Note: If you change the score code for the model, publish the model again to ensure that your score application uses the current scoring code.

6. Click Close in the confirmation message.

Verify the Published Model

View Publish History
To view the publish history of a model, select the Models page. To view the publish history of all models, select the Published tab on the History page. All models that have been published to a SAS Channel, to the SAS Metadata Repository, and to a database are displayed. Select a model from the list to view the full publish details.

To view the full publish details for a model:
1. Open a model and select the Model Properties tab.
2. Select History ➔ Published to view the publish history.

To view the full publish details for all models:
1. Open a project and select the History page.
2. Select the Published tab to view the publish history.

View a Published Model
To verify that SAS Model Manager successfully created the MiningResults object in the SAS Metadata Repository for a published model, use SAS Management Console. To view the contents of the published model or project, you can use SAS Data Integration Studio. You can also use SAS Management Console to export the MiningResults object to a SAS package.

To view a MiningResults object in the metadata repository:
1. Open SAS Management Console and log on to the SAS Metadata Server using the same user ID that you use to log on to SAS Model Manager.
2. Click the Folders tab and expand the folders to locate the model that you exported. When you select the folder, the right pane lists the MiningResults objects for the exported models.
3. Right-click the **Tree 1** MiningResults object and select **Properties** from the pop-up menu. The Properties window appears.

4. Examine the **Keywords** box on the **General** tab to verify that the MiningResults object contains the universally unique identifier (UUID) of the exported model. The UUID is a system property that SAS Model Manager automatically assigns to each model. To view a system property in SAS Model Manager, click the + icon beside the **System Properties** heading to expand the section.

5. You can use the UUID to conduct filtered searches and query the published models. For more information, see Appendix 1 in the *SAS Model Manager: User's Guide*.

6. Examine the metadata on the **Advanced** tab to determine when the MiningResults object was created or most recently updated.

6. Click **OK**.

---

**Publish the Champion Model**

To publish the champion model, you must have already assigned the champion model for the project. SAS Model Manager examines the project and always publishes the
champion model for the project. When the champion model for a project changes and you publish the model again at the project level, the scoring application automatically uses the latest score code.

To publish the champion model from a model project to the SAS Metadata Repository:
1. From the Projects category, select HMEQ and click .
2. Select SAS Metadata Repository as the publish destination.
3. Select Tree 1 from the models list.
4. The Publish Name is set as HMEQ.
5. Click Browse and select the location to publish the model to. Click OK.
6. Click Publish.
7. Click Close in the confirmation message.

---

**Publish Models to a SAS Channel**

In this tutorial, you publish models to a defined channel. Then you can extract and validate the scoring logic, deploy champion models to a production environment, and monitor the performance of your models.

To publish a model to a channel:
1. From the Projects category, select HMEQ and click .
2. Select SAS Channel as the publish destination.
3. Select Tree 1 from the models list.
4. Select a publication channel from the channel drop-down list.
5. (Optional) Click More Options to specify a message subject, notes, and user-defined properties. Click Save.
6. Click **Publish**.

7. Click **Close** in the confirmation message.

8. To view the full publish details for the model, select the **Published** tab on the **History** page of the HMEQ project.

The SAS package that is sent to the publication channel contains the model input, model output, SAS code, and the package properties. You can submit a SAS DATA step program that calls the SAS Publish API (Application Programming Interface) to extract and deploy the model to a testing or scoring server. SAS Model Manager also provides a SAS macro program, called MM_GetModels, that extracts the SAS code and metadata to score the model. Typically, extracted files are placed on a local drive of the scoring server that is used to deploy the published model. For more information, see the *SAS Model Manager: User's Guide*.

---

### Publish Models to a Database

#### Overview

In this tutorial, you publish the project champion model and challenger models to a configured database using either the SAS Embedded Process Publish Method or the Scoring Function Publish Method. There is also an example of publishing a model using the Hadoop Distributed File System.

For more information, see Chapter 17, “Publishing Models,” in *SAS Model Manager: User's Guide*. 
Publish a Model Using the SAS Embedded Process Publish Method

In this exercise, you publish a project's champion model to a database using the SAS Embedded Process publish method.

1. Verify that you have set the project champion model. For more information, see “Set a Champion Model” on page 58.
2. From the Projects category, select HMEQ and click .
3. Select a database type as the publish destination.
4. Select SAS Embedded Process for the publish method. The type of database and the publish method that you choose determine which database settings and options are required. The default publish method is SAS Embedded Process.
5. Select Tree 1 in the models list.
6. Enter a publish name for the champion model that you selected to publish or accept the default value. The SAS Embedded Process publish method uses only the publish name to publish the model files to the database.

Here are the naming convention requirements:

- The user-defined value is case insensitive. The maximum length of alphanumeric characters is determined by the database type and publish method that is selected. No spaces are allowed. An underscore is the only special character that can be included in the publish name.
- The recommended maximum length of the publish name for the SAS Embedded Process publish method is 30 alphanumeric characters for all database types. The database types that are currently supported by SAS Model Manager are DB2, Greenplum, Hadoop, Netezza, Oracle, SAP HANA, or Teradata.

Note: The publish name for each model is reserved by default for subsequent use of the publishing models for a project.

7. Enter a value for the database settings that appear for the selected database type and publish method. For more information about database settings, see “Publishing Models to a Database” in Chapter 17 of SAS Model Manager: User's Guide.
8. Click More Options. The <Database-type> Options window appears.

Select the check box for the desired validation options that appear for the selected database type:

- Keep scoring files if validation fails
- Display detailed log messages
- Use model input

9. Enter a numeric value for Sample Size. The default value for sample size is 100. The maximum number of digits that are allowed is 8.

10. Click Save.

Note: By default, Use model input is selected.
11. Click **Publish**. A message indicates whether the models were published to the database successfully.

   *Note:* The value of the publish name is validated against the target database. Validation occurs when the option **Replace scoring files that have the same publish name** is not selected for the SAS Embedded Process publish method. If the publish name is not unique, an error message is displayed.

12. Click **Close** to complete the publishing process.

13. To view the publish results, results log, and job history of the project, open the project and then select the **History** page.

---

**Publish a Model Using the Scoring Function Publish Method**

In this exercise, you publish a project’s champion model to a database using the scoring function publish method.

To publish a model:

1. Verify that you have set the project champion model. For more information, see “Set a Champion Model” on page 58.

2. From the Projects category, select **HMEQ** and click 

3. Select a database type as the publish destination.

4. Select **Scoring function** for the publish method. The type of database and the publish method that you choose determine which database settings and options are required. The default publish method is SAS Embedded Process.

5. Select **Reg 1** in the models list.

   *Tip* If you have not published the champion model, select the champion model **Tree 1**.

6. Enter a publish name for each model that you selected to publish. The scoring function publish method has a system-generated **prefix** and a **publish name**. These are used to publish the model scoring function. The publish name is a user-defined value that can be modified.

Here are the naming convention requirements:

- The user-defined value is case insensitive. The maximum length of alphanumeric characters is determined by the database type and publish method that is selected. No spaces are allowed. An underscore is the only special character that can be included in the publish name.

- The recommended maximum lengths of the publish names for the scoring function publish method are the following:
  - 19 alphanumeric characters for Teradata
  - 30 alphanumeric characters for Netezza, Greenplum, DB2, SAP HANA, and Hadoop

*UNIX Specifics*

The publish name (user-defined) portion of the function name in an AIX environment has a maximum length of 16 alphanumeric characters for Teradata.

*Note:* The publish name for each model is reserved by default for subsequent use of the publishing models for a project.
7. Enter a value for the database settings that appear for the selected database type and publish method. For more information about database settings, see “Publishing Models to a Database” in Chapter 17 of SAS Model Manager: User's Guide.


Select the check box for the desired validation options that appear for the selected database type:

- Keep scoring function if validation fails
- Display detailed log messages
- Use model input
- Protected mode (Teradata scoring function option) or Fenced mode (DB2 and Netezza scoring function option)

Note: By default, Use model input is selected for both publish methods. The Protected mode or the Fenced mode options are selected by default for the scoring function publish method.

9. Enter a numeric value for Sample Size. The default value for sample size is 100 if the value is null or zero. The maximum number of digits that are allowed is 8.
10. Click **Save**.
11. Click **Publish**. A message indicate whether the models were published to the database successfully.

   *Note:* The publish name portion of the **Function Name** is validated against the target database. The scoring function with the same publish name is replaced automatically.

12. Click **Close** to complete the publishing process.
13. To view the publish results, results log, and job history of the project, open the project and then select the **History** page.

**Example: Publish a Model Using the Hadoop Distributed File System**

In this exercise, a project's champion model is published to a Hadoop Distributed File System database. Your data and input will differ.

1. From the Projects category, select **HMEQ** and click **H**.
2. Select **Hadoop** as the publish destination.
3. **SAS Embedded Process** is the default publish method.
4. Select **Tree 1** in the models list.
5. Enter **Tree1** as the publish name.
6. Enter `greysky.unx.sas.com:8020` as the server and port number.
7. Enter `/tmp/mmtest` as the directory path.
8. Enter `greysky.unx.sas.com:8021` as the MapReduce server and port number.
9. Enter `hadoop` as the user ID.
10. Enter `hadoop1` as the password.
11. Click **More Options** and select the following:

- Keep scoring files if validation fails
- Display detailed log messages
- Use model input

12. Click **Save**.

13. Click **Publish**. A message indicates whether the models were published to the database successfully.

14. Click **Close** to complete the publishing process.

15. To view the publish results, results log, and job history of the project, open the project and then select the **History** page.
## Update Workflow

### Update the Workflow Process (Optional)

To complete the tasks in the associated workflow:

1. Click ✉️.

2. Select **Claim this task**.

3. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.

4. Click **Done**. The workflow process continues to the next task.

5. Repeat steps 2 and 3 for the tasks that you completed during this tutorial.

*Note:* For more information, see Chapter 12, “Tutorial 11: Using My Tasks and Managing Workflows,” on page 153.
Overview of Performance Monitoring

SAS Model Manager performance monitoring enables you to monitor and evaluate model performance. Model performance can sometimes be improved by tuning or refitting the model, or by using a new champion model.

To monitor performance, you create a performance definition and then you execute it or schedule it to run at a specific date and time. The output from executing a performance definition includes several charts, such as Characteristic, Stability, Lift, Gini (ROC and...
Trend), Kolmogorov-Smirnov (KS), and Mean Squared Error (MSE) charts. The New Report feature enables you to create a Monitoring report and a Champion and Challenger Performance report that uses the performance data as input. You can view these charts in SAS Model Manager or you can create monitoring reports in PDF, HTML, RTF, or Excel output formats.

Prerequisites

Tutorial 5 Models and Data Sets

The exercises in this tutorial depend on some of the properties of the specific models that were added in Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 37.

The performance data sets from SMM131Tutorials.zip must be extracted and registered in the SAS Metadata Repository. If the data sets have not been extracted and registered, see “Install and Register the Tutorial Files” on page 4 to extract and register the files.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.
Monitor the Performance of a Classification Project Champion Model

In this exercise, you run the Performance Definition wizard for the HMEQ classification modeling project to create a performance monitoring definition for the champion model, Tree 1. The performance monitoring job uses the information that you supply in the Performance Definition wizard to create SAS programs. You then execute the SAS programs in the performance job to create the performance monitoring data sets. Finally, you repeat the steps for the challenger model Reg 1.

Ensure the Project and Model Properties Are Set

The Performance Definition wizard requires that specific project and model properties be set before you can run the wizard.

1. Expand the Tutorial3 folder.
2. Open the HMEQ project and ensure that the following project properties are set:

<table>
<thead>
<tr>
<th>Project Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training target variable</td>
<td>BAD</td>
</tr>
<tr>
<td>Target event value</td>
<td>1</td>
</tr>
<tr>
<td>Class target level</td>
<td>Binary</td>
</tr>
<tr>
<td>Output event probability variable</td>
<td>score</td>
</tr>
</tbody>
</table>

3. Select the Models page.
4. Open the champion model Tree 1 and verify that the value of the Score code type property is set to DATA step.
5. Open the challenger model Reg 1 and verify that the value of the Score code type property is set to DATA step.

Edit and Execute the Performance Definition

To edit the performance definition:

1. Select the Performance page.
2. Click Edit Definition and select the champion model Tree 1.
Click Next.

3. Select a SAS Application Server (for example, the default is SASApp).

4. Click All to select all output variables for stability analysis.

5. Click All to select all input variables for characteristic analysis.

6. Click Next.

7. Select Standard configuration as the data processing method and select Run model score code to run the score code in the performance monitor job.

8. Select Static data sources or Dynamic data sources, and then specify the data source information. The default option is Static data sources.

   To use static data sources:
   a. Click +.
      
      Note: The data table whose collection date is the earliest is the baseline performance data table.
   b. Click the empty cell in the Data Source column.
   c. Click Browse and select the Tutorials.HMEQ_PERF_Q1 performance data source. Click OK.
d. Click the empty cell in the **Collection Date** column and click ![edit]. Select the date of **March 31, 2013**. The date can be any date in the time period when the performance data was collected.

e. Enter the label **Q1** in the **Report Label** column. The report label represents the time point of the performance data source. Because the report label appears in the performance charts, use a label that has not been used for another time period, is short, and is understandable.

   **Note:** If you duplicate report labels, previous performance results are overwritten.

f. (Optional) Select a data source and click ![select] to verify that the selected input variables and target variable are included in the performance data source.

g. (Optional) Repeat the above steps to add the following performance data sources to the performance definition.

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Collection Date</th>
<th>Report Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutorials.HMEQ_PERF_Q2</td>
<td>June 30, 2013</td>
<td>Q2</td>
</tr>
<tr>
<td>Tutorials.HMEQ_PERF_Q3</td>
<td>September 30, 2013</td>
<td>Q3</td>
</tr>
<tr>
<td>Tutorials.HMEQ_PERF_Q4</td>
<td>December 31, 2013</td>
<td>Q4</td>
</tr>
</tbody>
</table>

h. (Optional) To delete a data source from the performance definition, select the data source and click ![delete].

To use dynamic data sources:

a. Click ![library] to select the **Tutorials** data source library.
b. Enter the prefix `HMEQ_PERF` to remove it from the data source names in the selected library. The data source name is used for the report label. You remove the prefix so that it does not show as part of a report label on the charts. Also, if you have other data sources in the same library only the ones that have the specified prefix are used.

9. (Optional) Select **Generate dashboard reports after the performance monitoring has completed**. The dashboard definition must already exist.

10. Click **Next**.

11. Accept the defaults for the alert and warning conditions.

12. (Optional) To send the results by e-mail, click **+**. A new row is added to the table.
   a. Enter an e-mail address.
   b. Select either **Yes** or **No** if you want an alert or warning to be sent by e-mail when alert or warning thresholds have been exceeded.
   c. Select either **Yes** or **No** if you want a completion notice with the job status to be sent by e-mail every time the report runs.
13. Click **Save**.

14. Click ![image]

*Note:* You can also schedule a performance monitoring to be run at a specific date and time. For more information, see “Schedule Performance Monitoring” on page 87.

15. After the performance monitoring has been completed, a confirmation message appears. Click **Close**.

16. Click the **Results** tab to view the performance results.
Monitor the Performance of a Prediction Project

Champion Model

In this exercise, you run the Performance Definition wizard for the HMEQ-Interval prediction modeling project to create a performance monitoring definition for the champion model, `Reg1_Interval`. The performance monitoring job uses the information that you supply in the Performance Definition wizard to create SAS programs. You then execute the SAS programs in the performance job to create the performance monitoring data sets.

Ensure the Project and Model Properties Are Set

The Performance Definition wizard requires that specific project and model properties be set before you can run the wizard.

1. Expand the `Tutorial3` folder.

2. Open the HMEQ-Interval project and ensure that the following project-specific properties are set:

<table>
<thead>
<tr>
<th>Project Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training target variable</td>
<td>DEBTINC</td>
</tr>
<tr>
<td>Class target level</td>
<td>Interval</td>
</tr>
<tr>
<td>Output prediction variable</td>
<td>P_DEBTINC</td>
</tr>
</tbody>
</table>

3. Select the Models page.

4. Open the champion model `Reg1_Interval` and verify that the value of the Score code type property is set to DATA step.

Edit and Execute the Performance Definition

To edit the performance definition:

1. Select the Performance page.

2. Click Edit Definition and select the champion model `Reg1_Interval`.

Note: You can check the status of a job by clicking in the Job History tab. A new record appears after the job has completed.

17. Click the Definition tab on the Performance page and repeat steps 2 through 7 for the challenger model `Reg1`. The same settings and options that were specified for the champion model should be used.
Click **Next**.

3. Select a SAS Application Server (for example, the default is SASApp).

4. Click **All** to select all output variables for stability analysis.

5. Click **All** to select all input variables for characteristic analysis.

6. Click **Next**.

7. Select **Standard configuration** as the data processing method and select **Run model score code** to run the score code in the performance monitor job.

8. Select **Static data sources** or **Dynamic data sources** and then specify the data source information. The default option is **Static data sources**.
To use static data sources:

a. Click †.

   *Note:* The data table whose collection date is the earliest is the baseline performance data table.

b. Click the empty cell in the **Data Source** column.

c. Click **Browse** and select the **Tutorials.HMEQ_PERF_Q1** performance data source. Click **OK**.

d. Click the empty cell in the **Collection Date** column and click †. Select the date of **March 31, 2013**. The date can be any date in the time period when the performance data was collected.

e. Enter the label **Q1** in the **Report Label** column. The report label represents the time point of the performance data source. Because the report label appears in the performance charts, use a label that has not been used for another time period, is short, and is understandable.

   *Note:* If you duplicate report labels, previous performance results are overwritten.

f. (Optional) Select a data source and click † to verify that the selected input variables and target variable are included in the performance data source.

g. (Optional) Repeat the above steps to add the following performance data sources to the performance definition.

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Collection Date</th>
<th>Report Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutorials.HMEQ_PERF_Q2</td>
<td>June 30, 2013</td>
<td>Q2</td>
</tr>
<tr>
<td>Tutorials.HMEQ_PERF_Q3</td>
<td>September 30, 2013</td>
<td>Q3</td>
</tr>
<tr>
<td>Tutorials.HMEQ_PERF_Q4</td>
<td>December 31, 2013</td>
<td>Q4</td>
</tr>
</tbody>
</table>
h. (Optional) To delete a data source from the performance definition, select the data source and click \( \times \).

To use dynamic data sources:

a. Click \( \square \) to select a data source library.

b. Enter the prefix \texttt{HMEQ_PERF} to remove it from the data source names in the selected library. The data source name is used for the report label. You remove the prefix so that it does not show as part of a report label on the charts. Also, if you have other data sources in the same library only the ones that have the specified prefix are used.
9. (Optional) Select **Generate dashboard reports after the performance monitoring has completed**. The dashboard definition must already exist.

10. Click **Next**.

11. Accept the defaults for the alert and warning conditions.

12. (Optional) To send the results by e-mail, click 📧. A new row is added to the table.
   a. Enter an e-mail address.
   b. Select either **Yes** or **No** if you want an alert or warning to be sent by e-mail when alert or warning thresholds have been exceeded.
   c. Select either **Yes** or **No** if you want a completion notice with the job status to be sent by e-mail every time the report runs.

13. Click **Save**.

14. Click 🔄.

   **Note:** You can also schedule a performance monitoring to be run at a specific date and time. For more information, see “Schedule Performance Monitoring” on page 87.

15. After the performance monitoring has been completed, a confirmation message appears. Click **Close**.

16. Click the **Results** tab to view the performance results.
Note: You can check the status of a job by clicking in the Job History tab. A new record appears after the job has completed.

Schedule Performance Monitoring

Overview of Scheduling Performance Monitoring

After you create a performance definition, you can create a schedule to execute the definition to run on a specific day and at a specific time. You can schedule the definition to run hourly, daily, weekly, monthly, or yearly.

Before you can schedule a performance definition, your user ID and password must be made available to the SAS Metadata Repository. You must also sign in to SAS Model Manager using your full user credentials that were specified for your user account in SAS Management Console. For user accounts where a Microsoft Windows user ID is specified, you must enter your user ID in the format of domain\userID. Contact your system administrator to add or update your password, and to determine the correct user credentials for your user account.

You cannot edit a schedule for a performance definition. To modify a schedule, delete the schedule and create a new schedule.

After performance monitoring jobs execute, you can view the job history using the Job History tab on the Performance page.

Create the Schedule

To schedule a performance monitoring definition:

1. Click
2. On the Recurrence tab, select the recurrence pattern.

3. Specify the criteria for when and how often the job should be run.

4. (Optional) Select the Advanced tab.
   a. Select the server that schedules the job from the Scheduling server list box.
   b. Select the batch server that runs the job from the Batch server list box.
   c. Click Browse to select a location for the performance monitoring output. Click OK.

5. Click OK.

6. After the job has been scheduled, a confirmation message appears. Click Close.

7. Click the Results tab to view the performance results.

   Note: Performance schedules cannot be edited. To change the schedule, delete the schedule and create a new schedule.

    To delete a schedule, click Delete Performance Data Sets

   After a performance monitoring job has run, the performance data sets reside on the Results tab on the Performance page.

   To delete the performance data sets:
   1. Click the Results tab.
   2. Click . Confirm the deletion.

---

**Creating Output Formats for Performance Monitoring Reports**

**Create Monitoring Reports**

In this exercise, you use the New Report window to create the monitoring reports in the PDF output formats.

To create a Monitoring report:

1. Expand the Tutorial3 folder.
2. Open the **HMEQ** project and select the **Reports** page.

3. Click ‹ and select **Monitoring**.

4. Enter **PDF_PerfMonitoring** as the name of the report. The description is optional.

5. Select **PDF** for the output type.

6. Select **Seaside** for the style for the report. When the SAS default option is selected, the default style and themes are used in generating the report. For example, the SAS default style for the HTML output type is HTMLBLUE.

7. Click **Run**. The report is generated and appears in the default viewer for the selected output type.

*Note: If you are prompted, enter your user ID and password to view the report.*

---

**Create Champion and Challenger Performance Reports**

In this exercise, you use the New Report window to create champion and challenger performance report in the HTML output format.

To create a Champion and Challenger Performance report:

1. Expand the **Tutorial3** folder.

2. Open the **HMEQ** project and select the **Reports** page.

3. Click ‹ and select **Champion and Challenger Performance**.

4. Enter **HTML_ChampionChallengerPerf** as the name of the report. The description is optional.

5. Select **HTML** for the output type.

6. Select **Seaside** for the style for the report. When the SAS default option is selected, the default style and themes are used in generating the report. For example, the SAS default style for the HTML output type is HTMLBLUE.
7. Click **Run**. The report is generated and appears in the default viewer for the selected output type.

*Note:* If you are prompted, enter your user ID and password to view the report.

---

**Using Dashboard Reports**

**Overview**

The SAS Model Manager dashboard can provide reports that show the overall state of projects that are being monitored. The dashboard reports are produced from existing performance data sets. For each project, you can define dashboard report indicators by creating a dashboard definition. The dashboard definition is used to create the dashboard reports. You view the dashboard reports through the **Actions** menu. These reports are generated in HTML.

*Note:* The dashboard reports can be defined and generated only by SAS Model Manager administrators and advanced users.

In this exercise, you create a dashboard definition, generate the dashboard reports, and view the dashboard reports.

**Prerequisites**

**Models Used in Tutorial 3**

The exercises in this tutorial depend on some of the properties of the specific models that were added in Tutorial 3. Use the projects, versions, or models that are specified here. This tutorial is designed to follow Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 37.

**The Required Tutorial Files**

The exercises in this tutorial depend on the performance data sets that were created using the tutorial files in “Monitor the Performance of a Classification Project Champion Model” on page 77.
Dashboard Directory Configuration and Permissions

In SAS Model Manager 13.1, the dashboard reports directory is configured during installation. The default directory is `$SASConfigDir\Lev\AppData\SASModelManager13.1\Dashboard`. SAS Model Manager users must have permissions to this directory. For more information, see “Configuring the Dashboard Reports Directory” in Chapter 4 of *SAS Model Manager: Administrator’s Guide*.

Create a Dashboard Report Definition

Before you can create a dashboard definition you must have at least one project that contains performance data. For more information, see “Monitor the Performance of a Classification Project Champion Model” on page 77.

To create a dashboard definition:

1. Select a project and then select **Actions ⇒ New Dashboard Definition**.
2. Click + to add an indicator. The Add an Indicator window appears.

   ![Add an Indicator](image)

3. Select a template. The name and description are populated from the selected template.
4. (Optional) If the selected template requires a condition, modify the name and description. Click **Details** to view information about the selected indicator template.
5. Enter a condition if the **Condition** field has been configured for use.
6. Enter normal, warning, and alert values for the range definitions.

   **Table 6.1** Example Performance Indicator Values

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Category</th>
<th>Normal</th>
<th>Warning</th>
<th>Alert</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAR_P1</td>
<td>Characteristic</td>
<td>0 – 1</td>
<td>1 – 2</td>
<td>2 – 3</td>
</tr>
<tr>
<td>GINIDECAY</td>
<td>Model Assessment</td>
<td>0 – 0.2</td>
<td>0.2 – 0.4</td>
<td>0.4 – 0.6</td>
</tr>
<tr>
<td>Indicator Name</td>
<td>Category</td>
<td>Normal</td>
<td>Warning</td>
<td>Alert</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>--------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>STAB_P1</td>
<td>Stability</td>
<td>0 – 1</td>
<td>1 – 2</td>
<td>2 – 3</td>
</tr>
</tbody>
</table>

7. Click **OK**.

8. Repeat these steps for each indicator that you want to add.

9. Select one **Category Indicator** for each category, and one indicator as the **Project Indicator**.

   *Note:* The indicator that you select as a project indicator must also be a category indicator.

10. Click **Next**.

11. (Optional) Specify an e-mail address for each recipient who should receive an e-mail notification about the project status. Click **+**, select a project status, and enter an e-mail address. Click **Save**.

12. Click **Next**.

13. Accept the defaults for the report types to include in the dashboard report.

14. Click **Finish**.

   *Note:* You must define dashboard report indicators for all projects that you want to be included in your dashboard reports.

---

**Generate Dashboard Reports**

Before you generate dashboard reports, you must have at least one project that contains performance data. That project must have at least one dashboard report indicator that has been defined.

To generate dashboard reports:

1. Select **Actions ⇒ Generate Dashboard Reports**. The Generate Dashboard Reports window appears.
2. Select a style.
3. Select a report option:
   - Create reports and data tables for projects that have new performance monitoring data. This option is the default.
   - Update the style for all reports using the existing data tables.
   - Update all reports and data tables for projects whose performance monitoring data or report indicator definitions have changed.
4. (Optional) Select an option if you want to exclude one or more project types from the report.
5. Click OK. A confirmation window appears, stating that the dashboard report was created.
6. Click Close.

For more information about executing dashboard reports, see *SAS Model Manager: User's Guide*.

**View the Dashboard Reports**

To view the dashboard reports:

1. Click Actions ». View Dashboard Reports. A web page displays all of the dashboard reports for each project that has a dashboard definition.
2. Select a project name or status link to view the associated dashboard report. The Project Reports Index appears in a new window. If you select a status, only the dashboard reports for that time frame are displayed.

### Project Reports Index

<table>
<thead>
<tr>
<th>Time</th>
<th>Status</th>
<th>Project Indicator</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q4</td>
<td>▢</td>
<td>Number of predictors with deviation index exceeding 0.1</td>
<td><strong>KPI Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>KPI Trend Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Monitoring Report</strong></td>
</tr>
<tr>
<td>Q3</td>
<td>▢</td>
<td>Number of predictors with deviation index exceeding 0.1</td>
<td><strong>KPI Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>KPI Trend Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Monitoring Report</strong></td>
</tr>
<tr>
<td>Q2</td>
<td>▢</td>
<td>Number of predictors with deviation index exceeding 0.1</td>
<td><strong>KPI Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>KPI Trend Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Monitoring Report</strong></td>
</tr>
<tr>
<td>Q1</td>
<td>▢</td>
<td>Number of predictors with deviation index exceeding 0.1</td>
<td><strong>KPI Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>KPI Trend Dashboard Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Monitoring Report</strong></td>
</tr>
</tbody>
</table>

3. Select a link from the Report column to view the report details.

*Note:* To return to the Project Reports Index, select the browser's back button. To return to the All Projects dashboard, select the first tab in the browser window.
For more information about dashboard reports, see *SAS Model Manager: User's Guide*.

**Manage Project Dashboard Definitions**

To manage all project dashboard definitions:

1. Click **Actions ⇒ Manage Dashboard Definitions**. The Manage Dashboard Definitions window appears.

2. To edit a dashboard definition for a specific project:
   a. Select a project and click ✍. The Edit Dashboard Definition window appears.
   b. Make your changes. Click **Finish**.

3. For each dashboard report definition that you want to delete, select the project and ✗. A confirmation message appears. Click **OK** to confirm the definition.

4. Click **Close**.
Overview of Basel II Reports

Basel II reports in SAS Model Manager provide several statistical measures and tests to validate stability, performance, and calibration using Loss Given Default (LGD) and Probability of Default (PD) models. This tutorial shows you how to import LGD and PD models and create Basel II reports. For a description of the statistical measures, see Appendix 10, “Statistical Measures Used in Basel II Reports,” in SAS Model Manager: User’s Guide.

Prerequisites

Tutorial 6 Models and Data Sets

The exercises in this tutorial require that the Tutorial 6 data sets and models from SMM131Tutorials.zip be extracted, and the data sets be registered in the SAS Metadata
Repository. If they have not been extracted and registered, see “Install and Register the Tutorial Files” on page 4 to extract the files and register the data sets.

Importing models requires that you know where the SAS Model Manager administrator installed the Tutorial 6 models. If you do not know the location of the models, contact your SAS Model Manager administrator.

The data sets for the traffic light benchmarks and validation grade default thresholds that are used to create the Basel II reports are located in the directory `<server-name>\install-directory\Program Files\SASHome\SASFoundation\9.4\mmcore\sashelp`. This tutorial uses the default thresholds in the data sets that are located in the sashelp directory.

Here are the default Basel II data sets and index that are located in the sashelp directory:

- traffic_light_benchmarks.sas7bdat
- validation_grade.sas7bdat
- validation_grade.sas7bndx

It is not recommended to directly modify the data sets in the sashelp directory. Use one of the following methods if you want to change the default values before creating the Basel II reports.

- Copy the data sets from the sashelp directory to the location of the input table that is used when creating the Basel II reports. An example of the input table directory location is `C:\SMM131Tutorials\Data`.

- Assign the MMBASEL library reference (libref) using the Data category view in SAS Model Manager. The library name must also be MMBASEL if you use SAS Management Console to define the library. Copy the data sets and index from the sashelp directory to the new MMBASEL library location.

- The search order for the data sets is the following:
  1. The library where the input table is located.
  2. The MMBASEL library, if it exists.
  3. The sashelp directory that is located on the server where SAS was installed.


**Verify Your User ID as a Member of Model Manager User Groups**

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.
Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).

3. Click Sign In.

Organize the Model Hierarchy

In this exercise, you create a folder and a modeling project.

Create a Folder

To provide a folder to manage your modeling projects for this tutorial:

1. Select Models ⇒ Projects.
2. Select Tutorials ⇒ yourUserID.

   Note: If the Tutorials folder or a folder with your user ID does not already exist, see “Create Tutorials Folders” on page 12.

3. Click and select New Folder.
4. Enter Tutorial6 for the folder name.
5. (Optional) Enter a description for the folder. For example, enter Basel II Reports Tutorial.
6. Click Save.

The new folder appears in the Projects category view.

Create a New Project

To create a project that is associated with the classification model function:

1. Select the Tutorial6 folder.
2. Click and select New Project.
3. Enter PD for the project name.
4. Select Classification as the model function.
100  Chapter 7  •  Tutorial 6: Creating Basel II Reports

5. Click **Save**. The new project opens.

To create a project that is associated with the prediction model function:

1. Select the **Tutorial6** folder.
2. Click **and select New Project**.
3. Enter **LGD-Interval** for the project name.
4. Select **Prediction** as the model function.

5. Click **Save**. The new project opens.

### Define the Variables

To define the input and output variables for the **PD** project:

1. Select the **Variables** page, and on the **Input** tab, click **.**
2. Select **HMEQ_PROJECT_INPUT** from the **Tutorials** library, and click **OK**.
3. Click the **Output** tab and click ![icon](image)

4. Select **HMEQ_PROJECT_OUTPUT** from the **Tutorials** library, and click **OK**.

5. Click ![icon](image)

6. Click **Yes** in the confirmation message.

To define the input and output variables for the **LGD-Interval** project:

1. Select the **Variables** page, and on the **Input** tab click ![icon](image).

2. Select **LGD_PROJ_INPUT** from the **Tutorials** library, and click **OK**.
3. Click the **Output** tab and then click **+**.

4. Select **LGD_PROJ_OUTPUT** from the **Tutorials** library, and click **OK**.

5. Click **-**.

6. Click **Yes** in the confirmation message.

*Define the Project Properties*

To define the PD project properties that are used to create reports and score models:

1. Open the PD project.

2. Select **Properties ⇒ Specific**.

3. Specify values for these PD project properties:

   **Default test table**
   - Click **Browse**. In the Select Data Source window, select **HMEQ_TEST** from the **Tutorials** library, and click **OK**.

   **Default scoring input table**
   - Click **Browse**. In the Select Data Source window, select **PD_SCORE_INPUT** from the **Tutorials** library, and click **OK**.

   **Default scoring output table**
   - Click **Browse**. In the Select Data Source window, select **PD_SCORE_OUTPUT** from the **Tutorials** library, and click **OK**.
Default train table
Click Browse. In the Select Data Source window, select HMEQ_TRAIN from the Tutorials library, and click OK.

Training target variable
Enter BAD.

Target event value
Enter 1.

Class target level
Select Binary.

Output event probability variable
Select score.

4. Click .

To define the LGD-Interval project properties that are used to create reports and score models:

1. Open the LGD-Interval project.
2. Select Properties ⇒ Specific.
3. Specify values for these LGD-Interval project properties:

   **Default scoring input table**
   Click Browse. In the Select Data Source window, select LGD_SCORE_INPUT from the Tutorials library, and click OK.

   **Default scoring output table**
   Click Browse. In the Select Data Source window, select LGD_SCORE_OUTPUT from the Tutorials library, and click OK.
Training target variable
Enter 1gd.

Class target level
Select Interval.

Output prediction variable
Select p_lgd.

4. Click .

Import Models

In this exercise you import models into SAS Model Manager from a SAS model package file, and you also import a SAS code model from local files. Then you map the model variables. SAS code models consist of the SAS code and the model component files (metadata) that are used to process a model in SAS Model Manager. To import a SAS code model, at least three component files are required: the model score code, the model input file, and the model output file. For prediction or classification models, you also must prepare model target files.

Import Model Package Files

SAS Enterprise Miner and SAS/STAT linear model package files, or SPK files, contain complete model information. You can import SAS Enterprise Miner and SAS/STAT models even if they are not registered in the SAS Metadata Repository. For information about how to create a package file, see SAS Model Manager: User's Guide.
To import a model from a SAS package file:

1. Open the **PD** project.
2. Select the **Models** page.
3. Click ![Folder] and select from a SAS package file.

4. On the **Browse** tab, click **Select a Model** and navigate to the location of the file. For this example, use `<drive>:\SMM131Tutorials\Models\PD`, the folder that was installed by the SAS Model Manager administrator. For more information, see “Install and Register the Tutorial Files” on page 4.

5. Select the **hmeq_scorecard.spk** file and click **Open**.
6. Enter **HMEQ Scorecard** for the name for the model.
7. (Optional) On the **Record Location** tab, enter the location of the SAS package file.
8. Click **OK**.
9. Click **Close** in the confirmation message.

### Import SAS Code Models

1. Open the **LGD-Interval** project.
2. Select the **Models** page.
3. Click ![Folder] and select from local files.
4. In the **Choose a model template** box, select **Prediction**.
5. Click **Properties** and enter **LGD** as the **Name**.
6. Click **Files** and select the local files that match the template files. For the following files listed in the **Template Files** column, click in the corresponding cell in the **Local Files** column, and then click **Browse**. Navigate to `<drive>:\SMM131Tutorials\Models\LGD` and select the corresponding model files listed below. This action maps the tutorial model component filenames to the SAS Model Manager model component filenames.

<table>
<thead>
<tr>
<th>Template Files</th>
<th>Model Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>score.sas</td>
<td>lgd_score.sas</td>
</tr>
</tbody>
</table>
Template Files | Model Files
---|---
modelinput.sas7bdat | lgd_model_input.sas7bdat
modeloutput.sas7bdat | lgd_model_output.sas7bdat
target.sas7bdat | lgd_model_target.sas7bdat
outest.sas7bdat | lgd_model_est.sas7bdat
Training.sas | lgd_training.sas

*Note:* This file is needed only if you want to retrain the model.

7. Click **OK**.

8. Click **Close** in the confirmation message.

**Map Model Variables to Project Variables**

When the names for the model output variable are not identical to the names for the project output variables, you must map the variables.
To map model output variables to project output variables:

1. Map model variables for the HMEQ Scorecard model in the PD project. Open HMEQ Scorecard model from the Models page, and then select Model Properties ➨ Variables ➨ Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the Value column, select a variable, and click .

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>score</td>
<td>P_BAD1</td>
</tr>
</tbody>
</table>

2. Map model variables for the LGD model in the LGD-Interval project. Open the LGD model from the Models page, and then select Model Properties ➨ Variables ➨ Output Mapping. Ensure that the following model variables are mapped to their respective project variables. To map a model variable to a project variable, click in the box in the Value column, select a variable, and click .

<table>
<thead>
<tr>
<th>Project Variables</th>
<th>Model Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>p_lgd</td>
<td>p_lgd</td>
</tr>
</tbody>
</table>

---

Create Basel II Reports

In this exercise, you create the Basel II reports that are used to validate models. The Probability of Default (PD) report can be created only for a classification model. The Loss Given Default (LGD) report can be created only for a prediction model. After you create the reports, you view them on the Reports page of a project. The reports enable you to validate a candidate model in the displayed version.

Create a Probability of Default (PD) Report

To create a PD report:

1. Select the Reports page of the PD project.
3. Enter Tutorial-6 PD as the name of the report.
4. (Optional) Enter a description or accept the default value. The default value is The Probability of Default Model Validation.
   
   Note: The output type is PDF and the style is SAS default. These values cannot be changed for this report.
5. Select HMEQ Scorecard from the list of models.
6. Click Browse and select PD_SCORE_INPUT from the Tutorials library. Click OK. The table can contain only input variables, or it can contain both input and output variables.
Note: When a scoring input table for a PD report contains data and one or more time periods, do not contain default or non-default loan information. These time periods are not used to calculate the PD measurements. In a chart, time periods that are not used to calculate the PD measurements are represented with dashed lines.

7. Select whether to run the score code. If the input table contains only input variables, set Run score code to Yes. If the input table contains input and output variables, set Run score code to No. For this exercise set Run score code to Yes, since the PD_SCORE_INPUT table contains only input variables.

8. The Time period variable specifies the variable from the input table whose value is a number that represents the development period. This value is numeric. The time period for PD reports begin with 1. Accept the default value of period.

9. (Optional) In the Time label variable field, enter the variable from the input table that is used for time period labels. When you specify the time label variable, the report appendix shows the mapping of the time period to the time label. Enter a value of timelabel to include the appendix in the report.

10. (Optional) Click More Options to set the following options and then click OK:

Scorecard bin variable
  Specifies the variable from the input table that contains the scorecard bins. If the scoring job for the PD report is run outside SAS Model Manager, the scorecard bin variable must be a variable in the input table. If scoring is done within SAS Model Manager, do not include the variable in the input table. Accept the default value of scorecard_bin.
Scorecard points variable
Specifies the variable that contains the scorecard points. If the scoring job for the PD report is run outside SAS Model Manager, the scorecard points variable must be a variable in the input table. If scoring is done within SAS Model Manager, do not include the variable in the input table. Accept the default value of `scorecard_points`.

Cut-off value
Specifies either the maximum value or a variable that contains the cut-off value in the input table. It is used to derive the predicted event and to further compute accuracy, sensitivity, specificity, precision, and error rate. Accept the default value of `100`.

11. Click **Run**. The report is generated and appears in the default viewer for the selected output type. If you are prompted, enter your user ID and password to view the report.

Create a Loss Given Default (LGD) Report

To create an LGD report:
1. Select the **Reports** page of the **LGD-Interval** project.
2. Click and select **Loss Given Default**. The New Report window appears.
3. Enter **Tutorial-6 LGD** as the name of the report.
4. (Optional) Enter a description or accept the default value. The default value is **The Loss Given Default Report**.
   
   Note: The output type is **PDF** and the style is SAS default. These values cannot be changed for this report.
5. Select **LGD** from the list of models.
6. Click **Browse** and select **LGD_SCORE_INPUT** from the **Tutorials** library. Click **OK**. The table can contain only input variables, or it can contain both input and output variables.
7. Select whether to run the score code. If the input table contains only input variables, set **Run score code** to **Yes**. If the input table contains input and output variables, set **Run score code** to **No**. For this exercise set **Run score code** to **Yes**, since the **LGD_SCORE_INPUT** table contains only input variables.
8. The **Time period variable** specifies the variable from the input table whose value is a number that represents the development period. This value is numeric. The time period for LGD reports begin with 1. Accept the default value of **period**.
9. (Optional) In the **Time label variable** field, enter the variable from the input table that is used for time period labels. When you specify the time label variable, the report appendix shows the mapping of the time period to the time label. Enter a value of **timelabel** to include the appendix in the report.
10. Click **More Options** to set the following:

**Actual variable**
- Specifies the actual LGD variable. Accept the default value of `lgd`.

**Predicted variable**
- Specifies the project scoring output variable. If the scoring for the LGD report is performed outside SAS Model Manager, the input data set must include this variable. If the scoring for the LGD report is done by SAS Model Manager, the input data set should not include this variable. Accept the default value of `p_lgd`.

**Pool variable**
- Specifies the variable from the input table that is used to identify a two-character pool identifier. Accept the default value of `pool_id`.

**Note:** The variable names that you specify can be user-defined variables. A variable mapping feature maps the user-defined variables to required variables.

11. Click **Run**. The report is generated and appears in the default viewer for the selected output type. If you are prompted, enter your user ID and password to view the report.
Overview of Advanced Reporting

The advanced reporting capability of SAS Model Manager enables you to create three different types of reports.

- User-defined reports enable you to add enterprise-specific reports to your company’s existing list of reports.
- Ad hoc reports enable you to create one-of-a-kind reports as you need them.
- Aggregated reports enable you to combine multiple reports that you can distribute to company stakeholders.

To make it easy to create these reports, SAS Model Manager provides a number of SAS macro variables and SAS macro programs. These macros can be used to gain access to model-specific information as well as to more general folder and user information.

In this tutorial you perform the basic tasks for creating new reports. You also combine multiple reports by creating an aggregated report.
Prerequisites

Tutorial 7 Models and Data Sets

The exercises in this tutorial depend on some of the properties of the specific models that were added in Tutorial 2. Use the projects, versions, or models that are specified here. This tutorial is designed to follow Chapter 3, “Tutorial 2: Performing Basic SAS Model Manager Tasks,” on page 20.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.
   
   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.

Create a Simple Ad Hoc Report

In this exercise, you create a PDF file to display the macro variables that are available in the SAS Model Manager reporting environment:

1. Expand the Tutorial2 folder and open the Delinquency project.
2. Select the Reports page, click Add, and select Ad Hoc.
3. Enter RptVars for the name of the report.
4. Select Model 1 in the Select models table.

5. Copy the code from RptVars.sas in `<drive>\SMM131Tutorials\Sample Code` in a text editor.

6. In the SAS Editor, paste the code that you copied in the previous step.

7. Click Run.

8. The report is generated and appears in the default viewer for the selected output type.

Here is page 2 of the PDF report output:
Create an Ad Hoc Score Range Report

In this exercise, you create an ad hoc report to categorically display score ranges in an HTML report. To create output in HTML from an ad hoc report, ensure that the report code is enclosed by a SAS Model Manager formatting macro.

1. Expand the Tutorial2 folder and open the Delinquency project.
2. Select the Reports page, click , and select Ad Hoc.
3. Enter ScoreRange for the name of the report.
4. Select Model 1 in the Select models table.
5. Copy the code from ScoreRange.sas in <drive>\SMM131Tutorials\Sample Code in a text editor.
6. In the SAS Editor, paste the code that you copied in the previous step.
7. Modify the Score Range code to format the report in HTML, and set the report style.
   The ScoreRange.sas program uses the SAS Model Manager formatting macros, which enable user reports to be formatted in PDF, HTML, RTF, and Excel. A beginning formatting macro code precedes the report code. The ending formatting macro must be the last line of code in the report program.
   a. Add the arguments reportFormat=html and reportStyle=Seaside to the %MM_ExportReportsBegin macro argument list. Here is the modified macro:

   ```sas
   %MM_ExportReportsBegin(reportFormat=html, reportStyle=Seaside, fileName=ScoreRange);
   ```
   b. Add the argument reportFormat=html to the %MM_ExportReportsEnd macro argument list. Here is the modified macro:

   ```sas
   %MM_ExportReportsEnd(reportFormat=html);
   ```
8. Click Run. SAS Model Manager runs the report and creates the report on the Reports page.
9. To view the ScoreRange report, expand the ScoreRange folder, right-click ScoreRange.html, and select Open.

Here is the output from the FREQ procedure as a table and as a graph:
Configure and Run a User-defined Score Range Report

In this exercise, you make the Score Range report available by saving the report SAS code files and template to the SAS Content Server. You can then run the Score Range report from the Reports page. This exercise has two parts. In the first exercise, you upload the report files to the SAS Content Server. In the second exercise, you create a Score Range report.
Configure a User-defined Report

To make the Score Range report available to the SAS Content Server:

1. From the Projects category view, click ☐ and select New Template.
3. Click ☐ and navigate to <drive>\SMM131Tutorials\Sample Code. Select ScoreRange.sas and click Open. Click Save.
4. Repeat Steps 1 through 3 and select ScoreRangeMacro.sas.
5. Repeat Step 1 and then select Type ⇒ Report ⇒ XML Template.
6. Click ☐ and navigate to <drive>\SMM131Tutorials\Sample Code. Select ScoreRangeTemplate.xml and click Open. Click Save.

Run the New User-defined Report

To run the installed score range report:

1. Expand the Tutorial2 folder and open the Delinquency project.
2. On the Reports page, click ☐ and select Score Range Report.
3. Enter ScoreRange2 for the name of the report.
4. Select HTML for the output type.
5. Select Seaside for the style.
6. Select Model 1 from the list.
7. Click Run.
8. The report is generated and appears in the default viewer for the selected output type. To view the report output, see “Create an Ad Hoc Score Range Report” on page 114.

For more information about this task, see SAS Model Manager: User's Guide.

Combining Multiple Reports

About Combining Multiple Reports

SAS Model Manager administrators and advanced users can combine multiple reports from the Reports page to create a single, aggregated report. The format of the report can be PDF, HTML, or RTF. Aggregated reports are stored on the Reports page.

The reports that are selected are rerun to create the aggregated report. If the data set content that the selected reports use has changed since the last time you ran the report, the results might be different from the original reports. Ad hoc reports, LGD reports, and PD reports cannot be added to an aggregated report.

In this exercise, you combine multiple reports to create an aggregated report.
Create an Aggregated Report

To create an aggregated report:

1. Expand the Tutorial2 folder and open the Delinquency project.
2. Click the Aggregated tab on the Reports page, and then click .
3. Enter Tutorial-7 Aggregated Report for the name of the report.
4. (Optional) Enter a description for the report.
5. Select PDF for the output type.
6. Expand the Available reports section and select the Delta, Dynamic Lift, and Model Profile reports that you created in Tutorial 2.
7. Click the single right arrow. The reports appear in the Selected reports section.
8. (Optional) To order the reports, select a report, and use the up and down arrows.
9. When all of the reports are in the correct order, click Run.
10. The report is generated and appears in the default viewer for the selected output type.
### Overview of Using Advanced Features

If you are already familiar with the administrative and basic functions of SAS Model Manager, use this tutorial to learn the following tasks:

- create a new model template
- save the new model template to the SAS Content Server
- import a model that is described by the template
- generate a report on the model

#### Example Scope

- Example Scope

#### Prerequisites

- Tutorial 8 Models and Data Sets
- Verify Your User ID as a Member of Model Manager User Groups
- Sign In

#### Organize the Model Hierarchy

- Organize the Model Hierarchy
  - Create a Folder
  - Create a New Project
  - Define the Variables
  - Define the Project Properties

#### Create a Model Template

- Create a Model Template

#### Import a Model

- Import a Model
- Verify Model Properties
- Map Model Output Variables to Project Output Variables

#### Create an Ad Hoc Variable Importance Report

- Create an Ad Hoc Variable Importance Report
Example Scope

The model that is used in this tutorial is based on the ARBORETUM procedure, which is a SAS Enterprise Miner procedure.

Prerequisites

Tutorial 8 Models and Data Sets

The exercises in this tutorial require that the Tutorial 8 data sets and models from SMM131Tutorials.zip be extracted, and the data sets registered in the SAS Metadata Repository. If they have not been extracted and registered, see “Install and Register the Tutorial Files” on page 4 to extract and register the files.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.
Organize the Model Hierarchy

In this exercise, you create a modeling project.

Create a Folder

To provide an organizational folder to manage your modeling projects:
1. Click and select New Folder. The New Folder window appears.
2. Enter Tutorial8 for the folder name.
3. (Optional) Enter a description for the folder.
4. Click Save.

Create a New Project

To create a project and define the model function:
1. Select the Tutorial8 folder.
2. Click and select New Project. The New Project window appears.
3. Enter HmeqVars for the project name.
4. Select Classification as the model function.

Define the Variables

To define the input and output variables:
1. Specify the project input variables:
   a. On the Input tab of the Variables page, click.
   b. Select HMEQ_PROJECT_INPUT and click OK.
2. Specify the project output variables:
   a. On the Output tab of the Variables page, click.
b. Select HMEQ_PROJECT_OUTPUT and click OK.

3. Click 

**Define the Project Properties**

To define the properties that SAS Model Manager uses to create reports and score models:

1. On the Properties page, select Specific.
2. Enter values for these properties:

   - **Default test table**
     Click Browse. In the Select Data Source window, select HMEQ_TEST from the Tutorials library, and click OK.

   - **Default scoring input table**
     Click Browse. In the Select Data Source window, select HMEQ_SCORE_INPUT from the Tutorials library, and click OK.

   - **Default scoring output table**
     Click Browse. In the Select Data Source window, select HMEQ_SCORE_OUTPUT from the Tutorials library, and click OK.

   - **Default train table**
     Click Browse. In the Select Data Source window, select HMEQ_TRAIN from the Tutorials library, and click OK.

   - **Training target variable**
     Enter bad.

   - **Target event value**
     Enter 1.

   - **Class target level**
     Click the property value field and select Binary.

   - **Output event probability variable**
     Click the property value field and select score.

3. Click 

Create a Model Template

In this exercise, you modify an existing template to create a new model template. For information about creating a model template, see *SAS Model Manager: User's Guide*.

To create a model template:

1. From the **Projects** category view, click and select **Manage Templates**.
2. Select **ProcArborModelTemplate** and click .
3. Enter **ProcArborModelTemplateTutorial** as the filename.
4. In the code in the text box, revise the name **ProcArborModelTemplate** to **ProcArborModelTemplateTutorial**.
5. Click **Save**. Accept the confirmation message and then click **Close**.

---

**Import a Model**

**Import a Model**

In this exercise, you import a model using the user model template:

1. Open the **HmeqVars** project and select the **Models** page.
2. Click ![Folder icon](folder_icon.png) and select **from local files**.
3. From the **Choose a model template** drop-down list, select **ProcArborModelTemplateTutorial**. The custom properties and files appear below.
4. Click **Properties** and enter **ProcArbor** as the **Name**.
5. Click **Files** and select the local files from the SAS Workspace Server that match the template files. For the following objects listed in the **Template Files** column, click in the corresponding cell in the **Local Files** column, and then click **Browse**. Navigate to `<drive>:\SMM131Tutorials\Models\Model8` and select the corresponding model files listed below. This action maps the tutorial model component filenames to the SAS Model Manager model component filenames.

<table>
<thead>
<tr>
<th>Template Files</th>
<th>Model Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>score.sas</td>
<td>score8.sas</td>
</tr>
</tbody>
</table>
6. Click OK. The ProcArbor model appears on the Models page.

Verify Model Properties

Verify the following model properties:
2. On the Model Properties tab, select Specific.
3. Verify BAD as the value of the Target variable property.

4. Verify DATA step as the value of the Score code type property.

Map Model Output Variables to Project Output Variables

Because the project output variable name is not the same as the model output variable name, the output variables must be mapped. To map the variables:

3. Click the Value column for score and select P_BAD1.
4. Click $.

Create an Ad Hoc Variable Importance Report

In this exercise, you create a report that is based on the model's PROC ARBORETUM importance data.

1. Open the HmeqVars project and select the Reports page.
2. Click Ad Hoc.
3. Enter VariableImportance for the name of the report.
4. Select ProcArbor in the Select models table.
5. Copy the code from VarImportance.sas in the <drive>\SMM131Tutorials\Models\model8 folder in a text editor.
6. In the SAS Editor, paste the code that you copied in the previous step.
7. Click **Run**.

8. The report is generated and appears in the default viewer for the selected output type.

**Variable Importance**

![Relative Importance Chart](chart.png)
Overview of Retraining Models

Using SAS Model Manager, you can retrain models to respond to data and market changes. Retraining models enables you to update models and to improve model performance. When you define a model retrain definition, you can select multiple models to be retrained at the same time.

The model retrain definition enables you to specify a location to store comparison reports and retrain results. When you select the models to include in the comparison report, you can use the training data source or select a different data source to compare the performance of the new models. By default, the project champion model is selected to retrain.

Note: Only models that are created by using SAS Enterprise Miner, R models, or SAS/STAT linear models can be retrained.

In this tutorial, you perform the following tasks:

• define a model retrain definition
• execute the model retrain definition
• view the new retrained models and comparison report
Prerequisites

Tutorial 9 Models and Data Sets

The exercises in this tutorial depend on some of the properties of the specific project, version, and models that were added in Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 38 and Chapter 6, “Tutorial 5: Performance Monitoring and Using Dashboard Reports,” on page 75. The folder path is \Tutorial3 \HMEQ.

Before you define a model retrain definition, complete the following tasks:

• If you want to retrain the project champion model, ensure that the champion model is set.

• Verify that the training data set that is used in Tutorial 3 has been registered in the SAS Metadata Repository using the Data category view, so that you use the same data set as the training data source.

• Verify that the appropriate project and model properties are set.

Here is a list of properties:

Classification Project Properties
• Training target variable: BAD
• Target event value: 1
• Class target level: Binary
• Output event probability variable: score

Prediction Project Properties
• Training target variable: DEBTINC
• Class target level: Interval
• Output prediction variable: P_DEBTINC

Model Properties
• Score code type: DATA step
• Verify that all of the project output variables are mapped to the corresponding model output variables.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/ SASDecisionManager and press Enter. The Sign In page appears.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).

3. Click Sign In.
Define a Model Retrain Definition

To define a model retrain definition:

1. Open the Tutorial3 folder and the HMEQ project.
2. In the Definition tab on the Retrain page, click Edit Definition.
3. Select Tree 1 from the models list.
4. Select Standard configuration as the data processing method.
5. Select Register new trained model to register the new models in the destination version on the SAS Content Server.
6. Select New version as the destination version for the new model.
7. Click Browse to select HMEQ_TRAIN from the Tutorials library.
8. Click the SAS Application Server list and select a server.
9. Click Browse to select a report folder in which to store the comparison report.
   Note: By default, the report is stored in the SAS session’s working folder on the SAS Workspace Server. You can also create subfolders in which to store the report. Here is an example: c:\Users\mmanalyst\Documents\My SAS Files\9.4\Model Retrain\Reports
10. Click Browse to select a retrain results folder to store the model training results.
   Note: This setting is for informational purposes only. The data sets and files that are created during model retraining are stored in this location. By default, the training results are stored in the SAS session’s working folder on the SAS Workspace Server. You can also create subfolders in which to store the results. The length of the directory path for the retrain result folder must be equal to or less than 100 bytes. Here is an example: c:\Users\mmanalyst\Documents\My SAS Files\9.4\Model Retrain\Results
11. (Optional) Select Trace on to print trace information to the SAS log file.
12. (Optional) Select Retrain when the dashboard project status is Alert or Warning. If the dashboard project status is Alert, the model is automatically retrained. If the dashboard project status is Warning, select whether to retrain the model or ignore the task. If the dashboard project status is Normal, the model is not retrained.
13. Click Next.

14. Select Reg 1 and HMEQ_STAT_Item models to compare them to the retrained model.

   Note: If you do not select a model, the champion model is used to perform the comparison.

15. Specify the data source options:

   a. Select Use training data source if you want to use HMEQ_TRAIN as the comparison data source. The percent that is specified is the percentage of data that is used for model comparison; the other part of the data is used for training. The random seed value is used to generate the training data based on the random sampling method. For this example, the default values are used. However, you can either use the whole training data source to compare or you can partition it into two parts, based on partition percent and random seed. The percentage that is specified is the percentage of data that is used for model comparison; the other part of the data is used for training. The random seed value is used to generate the training data, based on the random sampling method.

   b. Click Browse to select a performance data set as the comparison data source. For example, you can select HMEQ_PERF_Q4 as the data source to reflect the data and market change when retraining the model.

16. Specify the report options:

   a. Enter a report name. Here is an example: HMEQ Model Comparison.

   b. Select the HTML format for the report output.
c. Select a style for the report. The available styles are SAS default, Seaside, Meadow, and Harvest. The default is SAS default.

17. Click Next.

18. (Optional) To send the retrain results by e-mail, click and enter an e-mail address.

19. Click Save.

20. After you create the retrain definition, you can either execute the definition or create a schedule to execute the definition on a specific day and at a specific time.

---

**Execute a Model Retrain Definition**

The prerequisites for retraining a model must be completed and a model retrain definition must be defined before you can execute a model retrain definition.

To execute a model retrain definition:

1. On the Retrain page, click 🚀

2. After the models are retrained, a confirmation message appears. Click Close.

3. Click the Results tab to view the results.

*Note:* You can check the status of a job by clicking ⦿ and then selecting the Results tab or the Job History tab.
Schedule a Retrain Definition

After you create a retrain definition, you can create a schedule to execute the definition to run hourly, daily, weekly, monthly, or yearly.

You cannot edit a schedule for a retrain definition. To modify a schedule, delete the schedule and create a new schedule.

After retrain jobs execute, you can view the job history using the Job History tab on the Retrain page.

To schedule a retrain definition:

1. On the Retrain page, click [Schedule a Retrain Definition]
2. On the Recurrence tab, select the recurrence pattern.
3. Specify the criteria for when and how often the job should be run.
4. (Optional) Click the Advanced tab.
   a. Select the server that schedules the job from the Scheduling server list box.
   b. Select the batch server that runs the job from the Batch server list box.
   c. Click Browse to select a location for the output and click OK.
5. Click OK.
6. After the job has been scheduled, a confirmation message appears. Click Close.
7. Click the Job History tab to view the job status.
8. After the job is complete, click the Results tab to view the retrain results.

Viewing Retrained Models and Model Comparison Reports

After a model retrain task is executed, the new retrained models and the retrained model comparison report are available on the Results tab on the Retrain page.

To view the retrain results and reports:

1. Select the Results tab on the Retrain page.
2. Double-click a result in the list. The report appears in your browser window. Here is an example of a lift chart that is part of the model comparison report.
Viewing Retrained Models and Model Comparison Reports

Lift Chart

![Lift Chart Image]

Legend:
- Model: HMEQ_STAT_ Item
- Reg 1
- Tree_1_20140905091802
Overview of Portfolios

SAS Model Manager enables you to create a portfolio in the model repository. From a portfolio level, you can create multiple projects from a control table, and then add new versions or new input variables to all projects within the portfolio. After you set the champion model for each project, you can monitor the performance of the champion models for all projects, and publish the champion models to the SAS Metadata Repository.
Prerequisites

Tutorial 10 Models and Data Sets

The exercises in this tutorial require that the Tutorial 10 data sets and models be extracted from SMM131Tutorials.zip, and the data sets be registered in the SAS Metadata Repository. If they have not been extracted and registered, see “Install and Register the Tutorial Files” on page 4 and “The Required Tutorial 10 Files” on page 10 to extract and register the files.

Importing models requires that you know where the SAS Model Manager administrator installed the Tutorial 10 models.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/ SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.
   
   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.

Organize the Model Hierarchy

In this exercise, you create a folder, a portfolio with multiple projects, and a version for each project within the portfolio.
Create a Folder

To provide a folder to manage your modeling projects for this tutorial:

1. Select Models ➔ Portfolios.
2. Select Tutorials ➔ yourUserID.
   
   Note: If the Tutorials folder or a folder with your user ID does not already exist, see “Create Tutorials Folders” on page 12.
3. Click and select New Folder.
4. Enter Tutorial10 for the folder name.
5. (Optional) Enter a description for the folder.
6. Click Save.

The new folder appears in the Portfolios category view.

Create a Portfolio

To create a portfolio:

1. When using a control table other than those that were provided in SMM131Tutorials.zip, verify that the project control table contains the required variables. For more information, see “Prerequisites for Creating Portfolios” in Chapter 7 of SAS Model Manager: User's Guide.
2. Select the Tutorial10 folder.
3. Click and select New Portfolio. The New Portfolio window appears.

![New Portfolio window]

Note: The value for the initial version is auto-populated and is the version name that is created within each project for the new portfolio.

4. Enter Portfolio1 for the name of the portfolio.
5. (Optional) Enter a description for the portfolio.
6. Click **Browse** to select the control table.

![Select Data Source](image)

For this exercise, select **CONTROL_TABLE** from the **Tutorials** library folder where you registered the data sets, and then click **OK**.

*Note*: If you want to set both a champion model and a challenger for the projects, use **CONTROL_TABLE2**.

7. Click **Browse** to select the location of the model SPK files that are specified in the control table (for example, `C:\SMM131Tutorials\Models\segmodels`).

   Click **OK**.

8. Select **Classification** for the model function to indicate the type of models that should be imported into each project within the portfolio.
9. Click **Next**.

10. Click **Browse** to select `HMEQ_PROJECT_INPUT` as the input table, and `HMEQ_PROJECT_OUTPUT` as the output table. The input and output variables in the tables are applied to all of the projects.

   ![New Portfolio](image)

   Click **Next**.

11. Specify the project properties to apply to all projects within the portfolio. The properties are used to perform tasks and generate reports.

   **Default test table**
   - Click **Browse**. In the Select Data Source window, select `HMEQ_TEST` from the `Tutorials` library, and click **OK**.

   **Training target variable**
   - Enter **BAD**.

   **Target event value**
   - Enter **1**.
Class target level
Select Binary.

Output event probability variable
Select score.

12. Click **Next** to view the summary of information that has been specified.

13. Click **Finish**.

14. Click **Close** in the confirmation message. The new portfolio appears in the list.

**Set a Champion Model**

In this exercise, you set a champion model for each project within the portfolio.
Set the Champion Model

To set a champion model:

1. Open Portfolio and select the Projects page.
2. Open a project and select the Models page.
3. Select one of the models and click ✔ to set the model as the project champion model.
   
   Note: You might receive a prompt if project or model variables have not been defined or mapped.

   The value in the Role column changes to Champion.
4. Repeat steps 1 through 3 for each project within the portfolio.

For more information, see “Champion Models” in Chapter 16 of SAS Model Manager: User’s Guide.

(Optional) Flag the Challenger Model

If you create your own project control table that contains more than one model in each project, you can set a challenger model after the champion model has been set. Both the champion model and challenger models must be set at the project level.

To flag a challenger model:

1. Open a project and select the Models page.
2. Select one of the models and click ✖ to flag the model as a challenger.
   
   Note: You might receive a prompt if project or model variables have not been defined or mapped.

   The value in the Role column changes to Challenger.
3. Repeat steps 1 through 3 for each project within the control group.

For more information, see “Challenger Models” in Chapter 16 of SAS Model Manager: User’s Guide.

Publish Project Champion Models from a Portfolio

In this exercise, you use the comprehensive publishing environment for model delivery to share models. Model delivery most often includes model score code and its associated input and output metadata. To publish the champion models for projects within a portfolio, you must have already set a model within each project as the champion model.

Publish Project Champion Models

In the Portfolios category view, you can publish the champion models for projects within a portfolio to the SAS Metadata Repository.
To publish champion models for projects in a portfolio:

1. Select a portfolio and click X.

2. Select one or more champion models that you want to publish from the models list.

3. Click Browse and select the location to publish the models to.

4. Click Publish.

5. Click Close in the confirmation message.

For more information, see “Publishing Project Champion Models” in Chapter 7 of SAS Model Manager: User's Guide.

### Publish Project Champion and Challenger Models

#### About Publishing Project Models
From the Projects page of a portfolio, you can publish the project champion model and its challengers to the SAS Metadata Repository, a SAS channel, or to a database.

#### Publish to the SAS Metadata Repository
1. Open Portfolio1 and select the Projects page.
2. Select a project and click X.
3. Select SAS Metadata Repository from the publish destination list.
4. Select one or more models that you want to publish from the models list.

5. Specify a Publish Name for the challenger models. The publish name for a champion model cannot be modified.

6. Click Browse and select the location to publish the models to.

7. Click Publish.

For more information, see “Publish to the SAS Metadata Repository” in Chapter 7 of *SAS Model Manager: User's Guide*.

**Optional) Publish to a SAS Channel**

1. Open Portfolio1 and select the Projects page.

2. Select a project and click 📦.

3. Select SAS Channel from the publish destination list.
4. Select the model that you want to publish from the models list.
5. Select a publication channel from the channel drop-down list.
6. (Optional) Click More Options to specify a message subject, notes, and user-defined properties. Click Save.
7. Click Publish.

For more information, see “Publish to a SAS Channel” in Chapter 7 of SAS Model Manager: User’s Guide.

(Optional) Publish to a Database
1. Open Portfolio1 and select the Projects page.
2. Select a project and click 
3. Select a database from the publish destination list.
5. Select one or more models that you want to publish from the models list.
6. Specify a Publish Name for each model.
   Note: The default format of the publish name is configured by the SAS administrator in SAS Management Console.
7. (Optional) Select whether to Replace scoring files that have the same publish name.
8. Specify an identifier to add to the database target table for each model.
9. (Optional) Select whether to Validate scoring results. If this option is selected, click Browse to navigate to the appropriate train table.
10. Specify the database settings.
11. Click More Options to specify other options for the database.
Monitor Performance of Project Champion Models

In this exercise, you define and execute a performance definition to create performance monitoring reports for all projects within a portfolio. Execution of the generated code creates the SAS data sets that are used to display the performance monitoring reports on the Performance page of each project.

To monitor the performance of the champion models for all projects:
1. Open Portfolio1 and select the Performance page.
2. Click Edit Definition.
3. Select one or more output variables for stability analysis. To select all output variables, click All.
4. Select one or more input variables for characteristic analysis. To select all input variables, click All.
5. Specify the performance data options.
   a. Click Browse and select the performance data source HMEQ_SEG_Q1 from the Tutorials library.
      
      Note: The performance data source must contain the same segment identifier variables as the control table. For this exercise the variable is segID.
b. To run the score code in the performance monitor job, select the **Run model score code** check box. If the check box is not selected, all of the output variables for stability analysis must be in the performance data source.

c. Click and select a date. The date can be any date in the time period when the performance data was collected.

   For this exercise, select **March 31, 2013**.

d. Enter a report label to associate with the performance data. The report label represents the time point of the performance data source. Because the report label appears in the performance charts, use a label that has not been used for another time period, is short, and is understandable (for example, Q1).

   **Note:** If you duplicate report labels, previous performance results are overwritten.

6. Specify the properties that are used to generate the performance monitoring reports. The properties default to the values that were set when you created a portfolio.

   ![Performance Definition](image)

   Click **Next**.

7. (Optional) Specify values for the alert and warning conditions or accept the defaults.

8. (Optional) To send the results by e-mail, click . A new row is added to the table.

   a. Enter an e-mail address.

   b. Select **Yes** if you want an alert or warning to be sent by e-mail when alert or warning thresholds have been exceeded.

   c. Select **Yes** if you want a completion notice with the job status to be sent by e-mail every time the report runs.
9. Click **Save**.

10. Click 🔄.

11. After the performance monitoring is complete, a confirmation message appears. Click **Close**.

12. (Optional) Repeat steps 2 through 11 to monitor performance of the champion models for multiple performance data sources.

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Collection Date</th>
<th>Report Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>HMEQ_SEG_Q2</td>
<td>June 30, 2013</td>
<td>Q2</td>
</tr>
<tr>
<td>HMEQ_SEG_Q3</td>
<td>September 30, 2013</td>
<td>Q3</td>
</tr>
<tr>
<td>HMEQ_SEG_Q4</td>
<td>December 31, 2013</td>
<td>Q4</td>
</tr>
</tbody>
</table>

13. To view the performance results, select the **Projects** page, and open a project. Select the **Performance** page to view results.
Add a New Version

In this exercise, you add a new version to all projects within a portfolio.

1. Open a portfolio, select the Projects page, and click . The Add a New Version window appears.

2. (Optional) Enter a description for each new version.

3. Click Save. The version number is incremented by one for each project within the portfolio.

4. Click OK for the confirmation message.

For more information, see “Overview of Project Versions” in Chapter 6 of SAS Model Manager: User's Guide.
Add an Input Variable

In this exercise, you add an input variable to each project within a portfolio.

1. Open a portfolio.

2. Select the Variables page and click the Input tab.

3. Click +.

4. Enter a name.

5. (Optional) Enter a description.

6. Select a type.

7. (Optional) Enter a measurement.

8. Enter a length.

9. Click OK. The input variable is added to the portfolio and to all projects within the portfolio.
Add Attachments

In this exercise, you view and add attachments such as images or documents. Attachments can be added at the object level for portfolios, projects, and models.

To add an attachment:
1. Select the Attachments page.
2. Click +.
3. Select a file to attach and click Open.

Note: Click × to remove an attachment.

Add Comments

In this exercise, you add new topics or respond to an existing topic. Comments can be added at the object level for portfolios, projects, and models.

To add a comment:
1. Select the Comments page.
2. Enter a topic name and a comment.
3. (Optional) Click to attach a file to the new topic. Repeat this step to attach multiple files.
   Note: You can also click Remove to remove an attachment.
4. Click Post.
**Chapter 12**

**Tutorial 11: Using My Tasks and Managing Workflows**

---

### Overview

SAS Model Manager uses the Workflows and My Tasks category views to interface with SAS Workflow. A workflow is a copy of a workflow template. A workflow can be used to track the progress of objects, such as model projects and rule flows at the version level. An authorized user can use SAS Workflow Studio to define workflow templates and to make them available to SAS Model Manager for use. Workflow templates contain the set of tasks, participants, policies, statuses, and data objects that comprise a business task. The status that you select when completing a task determines the next task in the workflow.

All users have access to view the My Tasks category view. Only administrators can view the Workflows category view.

This tutorial shows you the features of the My Tasks category view and how to manage workflows.
Prerequisites

Make Workflow Template Available

The exercises in this tutorial require that the workflow templates for Tutorial 2 or Tutorial 3 be available to SAS Model Manager. If you have permissions to upload workflow templates using SAS Workflow Studio and have access to the Workflows category, see Chapter 2, “Tutorial 1: Prepare for Using SAS Workflow,” on page 15. Otherwise, contact your SAS administrator or another authorized user.

Tutorial Project Setup

Before starting these exercises, you must have already created a new project in Tutorial 2 or 3. For more information, see Chapter 3, “Tutorial 2: Performing Basic SAS Model Manager Tasks,” on page 19 and Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 37.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.
   
   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.

Add a New Version

If you started and completed a workflow previously for a project as part of the exercises in Tutorial 2 or Tutorial 3, you can either start a new workflow for the same project version or you can add a new version.

To add a new version:

1. From the Projects category, expand Tutorials <your-userID> Tutorial#.
   
   Note: You can complete this exercise using either the Tutorial2 or Tutorial3 folder that was previously created.
2. Open a project (for example, open HMEQ in the Tutorial3 folder).
3. Select the Versions page.
5. The next sequential number appears as the new version number for the project.
6. (Optional) Enter a description for the version.
7. Click OK. The new version appears in the list. The icon that is displayed in the top right-hand corner for the new version indicates that it is now the displayed version.

For more information, see “Overview of Project Versions” in Chapter 6 of SAS Model Manager: User's Guide.
Start a Workflow

To start a new workflow:

1. Verify that the version that you want to start a workflow for is the currently displayed version on the **Versions** page of the project.
   
   *Note:* Each version of a project can have only one workflow in progress at a time. However, a project can have multiple workflows associated with different versions at one time.

2. Click 📚 in the project toolbar.

3. Enter **Tutorial 11** for the name for the new workflow.

4. (Optional) Enter a description for the workflow.

5. Select the template for this tutorial from which to create the workflow. For example, use **MM Tutorial 3 Workflow**.

   ![Start a new workflow for "HMEQ, 3.0".](image)

   - **Name:** Tutorial 11
   - **Description:**
   - **Template:** MM Tutorial 3 Workflow

6. Click **Start**. The 📚 icon is displayed in the right-hand corner for the associated version.

---

**Working with Workflow Tasks**

The **My Tasks** category view displays the tasks for workflows that are in progress and that you have been assigned as a potential owner or that have been claimed by you. In this exercise, you explore the content that is available in the **My Tasks** category view and complete tasks in a workflow.
To complete a task:

1. Click **Details** to view the task information. The **Details** section includes information about which model project and version the task is associated with, as well as the potential owners and possible actions that can be taken.

2. Click **View Workflow** to view the workflow diagram.

Click **Close**.
3. Select a task and click in order to open the associated object and perform the task.

   Note: If you click , the project is opened and the Models page is displayed for the associated version. The task is not claimed. If you click , the claimed status is set to Yes for the select task.

4. Navigate through the project’s pages to perform the steps for the current task. For example, select the Models page to import models.

5. Click .

   ![Task Details](image)

6. Select an action to take for the selected task. For this exercise, select Completed. The actions that are available are the status values for the task in the workflow.

7. Click Done. The workflow process continues to the next task.

8. Repeat steps 4 through 7 for each task until the workflow has been completed.

   For more information, see “Working with Workflow Tasks” in Chapter 18 of SAS Model Manager: User’s Guide.

---

**Manage Workflows**

**About Workflows**

The Workflows category can be used to manage workflows. You can create new workflows, view workflows, and interact with tasks that are associated with a workflow. If a user is assigned to the workflow role of business administrator, he or she can influence the progress of a task by performing actions such as assigning a task, or releasing the task that is claimed by another user. A user can also specify values for properties to share information with other users. After the workflow templates are made available, an application administrator can set the object mappings using the Workflows category view.

   Note: To view the Workflows category in the navigation pane, you must be a member of the Decision Manager Administrators group or a group that has been assigned the role of Decision Manager Common: Administration.

Select Workflows to view a list of the available workflows.
Assign Participants to Tasks

Default participants have already been assigned to tasks in the workflows that are used in the tutorials.

To assign an additional participant to a task:

1. From the Workflows category view, double-click a workflow. The Workflow details view is displayed.
2. Select a task, and then click in the Participants pane. The Assign a Participant window appears.
3. Select one of the identity types: user, group, or role.
4. Enter part of the user, group, or role name, and click .

Note: If you do not enter part of the name, all of the names for the selected identity type are displayed.
Select a name and click **OK**.

5. Select a workflow role for the participant.

Here are the workflow roles that you can assign to participants for a workflow task:

- **Business administrator**: a participant who can influence the progress of a task by actions such as assigning a task, or releasing the task that has been claimed by another user.

- **Potential owner**: a participant who can claim a task in a workflow process and who becomes the actual owner of a task.

6. Click **OK**. The new participant is added to the list in the Participants pane.

### Releasing a Task

An authorized user with access to the Workflows category view can release a task that has been claimed by a workflow participant. The name of the actual owner is displayed in the Participants pane.

To release a task:

1. From the Workflows category view, double-click the **Tutorial 11** workflow. The Workflow details view is displayed.

2. Select a task name, and click **OK**. The **Claimed By** value for the selected task is cleared and is now available to all potential owners.

### (Optional) Editing Task Properties

If you have created your own workflow template using SAS Workflow Studio and added data objects to a task, the objects appear as properties in the Properties pane when you select a task in the Workflow details view. Properties that are editable display a triangular icon in the bottom right corner of the property value in the data grid.

To edit the properties for a task:
1. From the Workflows category view, open the workflow, and select a task. The properties that are associated with the task are displayed to the right in the Properties pane.

2. Click on the property value, and then enter a value or change the existing value.

3. To save the changes to the properties, click ![Save](image). If you do not want to save the changes to the properties, click ![Cancel](image).

**Terminating a Workflow**

When you terminate a workflow process, all tasks that have not yet been completed are changed to a state of Terminated. After you terminate a workflow process, it cannot be restarted. However, you can start a new workflow for the same version.

To terminate a workflow:

1. From the Workflows category view, select a workflow name and click ![Terminate](image).

2. Click Yes to terminate the selected workflow.
Overview of Using Published Models in SAS Data Integration Studio

Prerequisites
- Tutorial 12 Models
- Verify Your User ID as a Member of Model Manager User Groups
- Sign In

Publish a Project Champion Model from SAS Model Manager

Score a Model Using a SAS Data Integration Studio Job
- Open the SAS Data Integration Studio Desktop
- Create a New Job
- Run the SAS Data Integration Studio Scoring Job
- Verify the Model Code Used in the Job

Declare and Publish a New Champion Model in SAS Model Manager

Update the Job to Use the Latest Champion Model

Overview of Using Published Models in SAS Data Integration Studio

The SAS Model Manager publish feature enables you to publish models to the SAS Metadata Repositories, making them available for other SAS products such as SAS Data Integration Studio and SAS Enterprise Guide.

When you publish a SAS Model Manager project champion model to the metadata repository, the result is a mining results object that contains the champion model of the project’s default version. In order for the mining results object in the SAS Metadata Repository to be updated with the new champion model, two conditions must be met: the champion model in the project’s default version is changed and the model is published from the project level again to the same SAS metadata folder.

To illustrate an application that can use a published SAS Model Manager project champion model, this tutorial uses SAS Data Integration Studio to connect metadata objects (including a mining results object) to create a scoring job.
Prerequisites

Tutorial 12 Models

The exercises in this tutorial depend on some of the properties of the specific models that were added in Chapter 4, “Tutorial 3: Importing Models, Scheduling Scoring Tests, and Creating Reports,” on page 38. Use the projects, versions, or models that are specified here. This tutorial is designed to follow Tutorial 3.

The scoring input and output tables from SMM131Tutorials.zip must be extracted and registered in SAS Metadata Repository. If they have not been extracted and registered, see “Install and Register the Tutorial Files” on page 4 to extract and register the files.

The users must also have Write and Modify permissions to <server-name><drive>\SMM131Tutorial\Data.

This exercise requires SAS Data Integration Studio. Use the SAS Deployment Wizard to install the SAS Data Integration Studio client.

Verify Your User ID as a Member of Model Manager User Groups

In this exercise, you ensure that your user ID is a member of the Model Manager Advanced Users group.

1. Open SAS Management Console and log on to the SAS Metadata Server.
2. On the Plug-ins tab, select User Manager.
3. Find and double-click your user ID in the right pane of SAS Management Console.
4. Click the Groups and Roles tab. Review the Member of pane and locate the group Model Manager Advanced Users. If your user ID is not a member of this group, ask your administrator to add you to this group. Close the properties window.

Sign In

To sign in to SAS Model Manager:

1. In the address bar of your web browser, enter http://hostname:port/SASDecisionManager and press Enter. The Sign In page appears.
2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   Note: To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, domain\myuserID).
3. Click Sign In.
Publish a Project Champion Model from SAS Model Manager

In this exercise, you publish a project champion model from SAS Model Manager in order for that model to be accessed and scored by SAS Data Integration Studio. When you publish from the project level, you publish the project champion model.

Note: This task requires that you use a user ID that is a member of the SAS Model Manager Advanced Users group or the SAS Model Manager Administrator Users group.

Note: If you create user-defined properties at the project level, these properties are published with the champion model. User-defined properties might be helpful for scoring applications that search mining result objects for specific name-value pairs. Each user-defined project property is stored in the SAS Metadata Repository as an Extension metadata object, which is a name-value pair.

1. Open the Tutorial3 folder and select the HMEQ project.
2. Click and select SAS Metadata Repository from the publish destination list.
3. Select Tree 1 from the list of models.
4. Click Browse and navigate to the folder where you want to store the model. For example, double-click Shared Data ➔ Model Manager and then select the TutLib folder. Click OK.
5. Click Publish.
6. An information message indicates whether the champion model was successfully published. Click Close.

Score a Model Using a SAS Data Integration Studio Job

In this exercise, you create a SAS Data Integration Studio scoring job by using the HMEQ mining result from the SAS Metadata Repository. After you create the job, you run the job and view the output.

Open the SAS Data Integration Studio Desktop

To log on to SAS Data Integration Studio:

1. Launch SAS Data Integration Studio.
2. If prompted, create a SAS Metadata Profile for the SAS Metadata server.
3. Log on with the profile for SAS Metadata server.

Create a New Job

To create a new job:
1. Use the New Job Wizard to add the job:
   a. From the SAS Data Integration Studio window, right-click My Folder. Then select New \( \Rightarrow \) Job. The New Job dialog box appears.
   b. In the Name box, enter Tutorial12 and click OK.

   Note: If prompted to choose a default application server, select SASApp, click Test Connection, and click OK in the confirmation message. Then click OK in the Default Application Server window.

   c. Click the Inventory tab, expand Table, and find the tables SCORE_INPUT and SCORE_OUTPUT that have the folder location for the Tutorial12 data sets. Here is an example: /Shared Data/Model Manager/Tutorial12.

   d. Click and drag SCORE_INPUT to the Diagram tab. Click and drag SCORE_OUTPUT to the Diagram tab. Position the SCORE_INPUT node so that it is now the farthest to the left. Position the SCORE_OUTPUT node so that it is now the farthest to the right. These nodes are the beginning and ending nodes in the diagram. Leave enough space between them for two additional diagram nodes to occupy.

   e. Click the Transformations tab and expand Access. Select and drag Table Loader to the Diagram tab. Place the Table Loader node before the SCORE_OUTPUT node.

   f. From the Transformations tab, expand Data. Select and drag Model Scoring to the Diagram tab. Place the Model Scoring node between the SCORE_INPUT node and the Table Loader node. Here is the Diagram tab:
Double-click the **Model Scoring** node. The Model Scoring Properties window appears. Click the **Models** tab, expand **Mining Results**, and select HMEQ. The UUID in the **Key** box is the UUID of the HMEQ project in SAS Model Manager.

2. Click the **Target Table Columns** tab. Expand **OutputTable**, select **score**, and click the right-arrow button. Click **OK**.

3. Drag the output handle from the **SCORE_INPUT** node to the **Model Scoring** node. The half-filled circle on the **Model Scoring** node is changed to a check mark to indicate that the node requirements have been met.

4. Drag the output handle from the **Model Scoring** node to the **Table Loader** node.

5. Drag the output handle from the **Table Loader** node to the **SCORE_OUTPUT** node. The half-filled circle on the **Table Loader** node is changed to a check mark to indicate that the node requirements have been met. Here is the diagram:

6. Save the job. Click **File ➤ Save**.

**Run the SAS Data Integration Studio Scoring Job**

To run the job and view the output:

1. On the **Diagram** tab, click **Run**. The Tutorial12 job runs. Here is the job status:
2. To view the output, right-click the `SCORE_OUTPUT` node and select `Open`. Here is part of the output:

![View Data: SCORE_OUTPUT](image)

### Verify the Model Code Used in the Job

To verify that you have used the correct model, view the model code that was used in the SAS Data Integration Studio job.

Click the **Code** tab and scroll through the lines until you find the following comment block:

```
*------------------------------------------------------------*;
* TOOL: Score Node;                                          *
* TYPE: ASSESS;                                              *
* NODE: Score;                                               *
*------------------------------------------------------------*;
* EM SCORE CODE;                                             *
```
The **NODE** value that is associated with **TYPE: MODEL** is the model name. In this case, the model name is **Tree**.

---

**Declare and Publish a New Champion Model in SAS Model Manager**

In this exercise, you declare a different model as the champion model after an initial project champion model has been published to the SAS Metadata Repository. You then publish the new project champion model to the metadata repository.

To declare and publish a new champion model:

1. Open the **Tutorial3** folder and the **HMEQ** project.
2. On the **Models** page, select **Reg 1** and click ![checkmark] to set the model as the project champion model.
3. When prompted to confirm the change, click **Yes**.
4. Open the **Tutorial3** folder and select the **HMEQ** project.
5. Click ![folder] and select **SAS Metadata Repository** from the publish destination list.
6. Select **Reg 1** from the models list.
7. Click **Browse** and navigate to the folder where you want to store the model. For example, double-click **Shared Data ⇒ Model Manager** and then select the **TutLib** folder. Click **OK**.
8. Click **Publish**. An information message indicates that a champion model already exists. Click **Replace** to replace the model.
9. An information message indicates whether the champion model was successfully published. Click **Close**.

For more information about this task, see the **SAS Model Manager: User's Guide**.
Update the Job to Use the Latest Champion Model

This exercise demonstrates the steps to update the SAS Data Integration Studio job after you change the champion model in SAS Model Manager. After you publish the HMEQ project from SAS Model Manager, SAS Data Integration Studio recognizes a new mining results object.

To update the job:

   a. Click the Tutorial12 window and select File → Close.
   b. Click the Folders tab and expand My Folder. Double-click Tutorial12 to reopen the job. When the job reopens, it uses the new score code from the Mining Result object and regenerates the code that is associated with the job.

2. In the Tutorial12 diagram, right-click the Model Scoring node and select Properties. The Model Scoring Properties window appears. Click the Models tab. The HMEQ mining result is highlighted. The Algorithm box shows that the model is a Regression model.

3. Click the Model Attributes tab. A message box might appear that warns of potential table changes if you change the mining result. Click Yes.

4. Click View Source Code. Scroll to the top of the window. Compare the text in the comment tags to the Reg 1 model code in SAS Model Manager. They are the same, as shown in the displays below.

To view the model code in SAS Model Manager:

a. Open the Tutorial3 folder and the HMEQ project.

b. On the Models page, open the Reg 1 model and select the Model Properties tab.

c. Select Advanced → Source Code.

Here is the Reg 1 score code in SAS Model Manager.
5. Click **Cancel** to close the View Source Code window.

6. Identify the variables to be used in the transform output. Click the **Target Table Columns** tab. If **score** and **customer_id** are not in the **Selected** list, move them manually:
a. From the Available list, select score and click the right arrow button to move the score variable to the Selected list.

b. From the Available list, expand SCORE_INPUT, select customer_id, and click the right arrow button to move the customer_id variable to the Selected list.

7. Click the Mappings tab. Right-click the space between the two lists of variables and select Map All. Here is the Mappings tab:

Click OK.

8. Double-click the Table Loader node and click the Mappings tab.

9. Right-click the space between the two lists of variables and select Map All. Click OK.


11. To view the output, right-click the SCORE_OUTPUT node and select Open. Here is a partial view of the output:

![Partial view of the output](image-url)
### View Data: SCORE_OUTPUT

<table>
<thead>
<tr>
<th>#</th>
<th>customer_id</th>
<th>score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>18-296-340</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>2</td>
<td>126-291-396</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>3</td>
<td>154-253-305</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>4</td>
<td>107-261-352</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>5</td>
<td>184-207-395</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>6</td>
<td>129-227-360</td>
<td>0.1150766...</td>
</tr>
<tr>
<td>7</td>
<td>197-222-368</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>8</td>
<td>141-255-328</td>
<td>0.1078593...</td>
</tr>
<tr>
<td>9</td>
<td>147-284-363</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>10</td>
<td>158-258-337</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>11</td>
<td>172-250-352</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>12</td>
<td>192-268-329</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>13</td>
<td>139-247-367</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>14</td>
<td>117-216-306</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>15</td>
<td>130-293-389</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>16</td>
<td>156-205-313</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>17</td>
<td>151-243-317</td>
<td>0.0691795...</td>
</tr>
<tr>
<td>18</td>
<td>166-240-312</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>19</td>
<td>145-220-357</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>20</td>
<td>173-244-305</td>
<td>0.0400147...</td>
</tr>
<tr>
<td>21</td>
<td>152-234-302</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>22</td>
<td>171-253-344</td>
<td>0.0691795...</td>
</tr>
<tr>
<td>23</td>
<td>194-271-310</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>24</td>
<td>117-227-361</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>25</td>
<td>142-207-335</td>
<td>0.0691795...</td>
</tr>
<tr>
<td>26</td>
<td>170-219-315</td>
<td>0.1256677...</td>
</tr>
<tr>
<td>27</td>
<td>156-227-332</td>
<td>0.0319573...</td>
</tr>
<tr>
<td>28</td>
<td>156-204-343</td>
<td>0.0691795...</td>
</tr>
<tr>
<td>29</td>
<td>191-252-372</td>
<td>0.0891795...</td>
</tr>
<tr>
<td>30</td>
<td>190-257-319</td>
<td>0.0891795...</td>
</tr>
</tbody>
</table>
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.